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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Introduction 1
These instructions contain all information required to commission and use the device. Read the 
instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation.
The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers.

1.1 Document history
The following table shows major changes in the documentation compared to the previous 
edition. 
The most important changes in the documentation when compared with the respective 
previous edition are given in the following table.

Edition Note
06/2020 Second edition

• Chapter Technical data (Page 103) updated
• Overall revision of chapters and contents

06/2017 First edition

NOTICE
Use in a domestic environment
This Class A Group 1 equipment is intended for use in industrial areas.
In a domestic environment this device may cause radio interference.

1.2 Product compatibility FC410
Manual 
edition

Remarks Device revision Compatibility of device integration package

06/2020 Manual upda‐
ted

Modbus RS-485 RTU
FW: 4.00.00-xx
HW: 3

SIMATIC PDM V8.2 Service 
Pack 1 or later

EDD: 2.00.01 or later

12/2019 Manual upda‐
ted

Modbus RS-485 RTU
FW: 4.00.00-xx
HW: 3

SIMATIC PDM V8.2 Service 
Pack 1 or later

EDD: 2.00.01 or later

SITRANS FC410/FCS400
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Manual 
edition

Remarks Device revision Compatibility of device integration package

06/2017 New Hardware 
extending sen‐
sor sizes

Modbus RS-485 RTU
FW: 4.00.00-xx
HW: 3

SIMATIC PDM V8.2 Service 
Pack 1

EDD: 2.00.xx or later

05/2015 Update of Mod‐
bus holding 
registers: Mod‐
bus address 
2215 to 2218 
added. 

Modbus RS-485 RTU
FW: 2.03.03-01
HW: 2

SIMATIC PDM 8 EDD: 1.01.00-00

12/2013 First edition Modbus RS-485 RTU
FW: 2.03.02-01
HW: 2

SIMATIC PDM 6 EDD: 1.00.01-01

1.3 Items supplied

With M12 plug connection
• SITRANS FC410/FCS400 flowmeter
• Micro SD card with production cer‐

tificates
• DVD containing software, certifi‐

cates and device manuals

Introduction
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With sensor terminal housing
• SITRANS FC410/FCS400 flowmeter
• Packet of cable glands
• Micro SD card with production cer‐

tificates
• DVD containing software, certifi‐

cates and device manuals

Note
Supplementary information
Supplementary product and production specific certificates are included on the SensorFlash® SD 
card.

Note
Scope of delivery may vary, depending on version and add-ons. Make sure the scope of delivery 
and the information on the nameplate correspond to your order and the delivery note.

1.4 Checking the consignment
1. Check the packaging and the delivered items for visible damages.
2. Report any claims for damages immediately to the shipping company.
3. Retain damaged parts for clarification.
4. Check the scope of delivery by comparing your order to the shipping documents for 

correctness and completeness.  
WARNING

Using a damaged or incomplete device
Risk of explosion in hazardous areas.
• Do not use damaged or incomplete devices.

1.5 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.

Introduction
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In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions form one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. These systems, machines and components should only be connected 
to the enterprise network or the Internet if and only to the extent necessary and with appropriate 
security measures (firewalls and/or network segmentation) in place.
You can find more information on protective measures in the area of industrial security by 
visiting:
https://www.siemens.com/industrialsecurity.
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends performing product updates as soon as they are available and 
using only the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
https://www.siemens.com/industrialsecurity.

1.6 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical data 
(Page 103).
The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or legal relationship. The sales contract contains all obligations on the part of 
Siemens as well as the complete and solely applicable warranty conditions. Any statements 
regarding device versions described in the manual do not create new warranties or modify the 
existing warranty.
The content reflects the technical status at the time of publishing. Siemens reserves the right to 
make technical changes in the course of further development.

Introduction
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Safety notes 2
2.1 Preconditions for use

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications relevant 
to safety.
Observe the information and symbols on the device. Do not remove any information or symbols 
from the device. Always keep the information and symbols in a completely legible state.

Symbol Explanation
Consult operating instructions

     
Use the device only for flow measurement in accordance with this operating instructions and 
observe the technical data (Page 103).

WARNING
Improper device modifications   
Risk to personnel, system and environment can result from modifications to the device, 
particularly in hazardous areas.
• Only carry out modifications that are described in the instructions for the device. Failure to 

observe this requirement cancels the manufacturer's warranty and the product approvals.

2.2 Laws and directives
Observe the safety rules, provisions and laws applicable in your country during connection, 
assembly and operation. These include, for example:     
• National Electrical Code (NEC - NFPA 70) (USA)
• Canadian Electrical Code (CEC) (Canada)
Further provisions for hazardous area applications are for example:   
• IEC 60079-14 (international)
• EN 60079-14 (EU)

SITRANS FC410/FCS400
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US Installations only: Federal Communications Commission (FCC) rules

Note
• This equipment has been tested and found to comply with the limits for a Class A digital 

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment.

• This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the operating instructions, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference to radio communications, in which case the user will be required to 
correct the interference at his own expense.

2.2.1 Conformity with European directives
The CE marking on the device symbolizes the conformity with the following European directives:

Electromagnetic 
compatibility EMC 
2014/30/EU

Directive of the European Parliament and of the Council on the harmoni‐
sation of the laws of the Member States relating to electromagnetic com‐
patibility

Low voltage direc‐
tive LVD 
2014/35/EU

Directive of the European Parliament and of the Council on the harmoni‐
sation of the laws of the Member States relating to the making available 
on the market of electrical equipment designed for use within certain 
voltage limits

Atmosphère explo‐
sible ATEX 
2014/34/EU

Directive of the European Parliament and the Council on the harmonisa‐
tion of the laws of the Member States relating to equipment and protec‐
tive systems intended for use in potentially explosive atmospheres

Pressure equipment 
directive PED 
2014/68/EU

Directive of the European Parliament and of the Council on the approxi‐
mation of the laws of the Member States concerning pressure equipment

2011/65/EU RoHS Directive of the European Parliament and the Council on the restriction of 
the use of certain hazardous substances in electrical and electronic equip‐
ment

The applicable directives can be found in the EC conformity declaration of the specific device.

Note
CE declaration
The CE declaration certificate is available on the SensorFlash SD card delivered with the device. 

Safety notes
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2.3 Requirements for special applications
Due to the large number of possible applications, each detail of the described device versions for 
each possible scenario during commissioning, operation, maintenance or operation in systems 
cannot be considered in the instructions. If you need additional information not covered by 
these instructions, contact your local Siemens office or company representative. 

Note
Operation under special ambient conditions
We highly recommend that you contact your Siemens representative or our application 
department before you operate the device under special ambient conditions as can be 
encountered in nuclear power plants or when the device is used for research and development 
purposes.

2.4 Use in hazardous areas
Qualified personnel for hazardous area applications
Persons who install, connect, commission, operate, and service the device in a hazardous area 
must have the following specific qualifications:   
• They are authorized, trained or instructed in operating and maintaining devices and systems 

according to the safety regulations for electrical circuits, high pressures, aggressive, and 
hazardous media.

• They are authorized, trained, or instructed in carrying out work on electrical circuits for 
hazardous systems.

• They are trained or instructed in maintenance and use of appropriate safety equipment 
according to the pertinent safety regulations.

WARNING
Use in hazardous area
Risk of explosion.
• Only use equipment that is approved for use in the intended hazardous area and labeled 

accordingly.
• Do not use devices that have been operated outside the conditions specified for hazardous 

areas. If you have used the device outside the conditions for hazardous areas, make all Ex 
markings unrecognizable on the nameplate.

Safety notes
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WARNING
Loss of safety of device with type of protection "Intrinsic safety Ex i"
If the device or its components have already been operated in non-intrinsically safe circuits or 
the electrical specifications have not been observed, the safety of the device is no longer 
ensured for use in hazardous areas. There is a risk of explosion.
• Connect the device with type of protection "Intrinsic safety" solely to an intrinsically safe 

circuit.
• Observe the specifications for the electrical data on the certificate and/or in Technical data 

(Page 103).

2.4.1 Installation in hazardous areas

WARNING
Equipment used in hazardous areas
Equipment used in hazardous areas must be Ex-approved for the region of installation and 
marked accordingly. It is required that the special conditions for safe use provided in the 
manual and in the Ex certificate are followed!

Hazardous area approvals   
The device is approved for use in hazardous areas and has the approvals listed below. Special 
conditions for safe installation and operation specified by each approval authority are included 
in the relevant certificate.

See also
Certificates and approvals (Page 109)

Special conditions for safe use
In general, it is required that:
• EN/IEC 60079-14 is considered for installation in hazardous areas.
• Appropriate cable connectors are used.
• Sensor is connected to the potential equalization throughout the hazardous area.
• The device is not opened when energized and when an explosive gas or dust atmosphere 

may be present.
Further information and instructions including approval-specific special conditions for safe use 
in Ex applications can be found in the certificates on the documentation disk and at the product 

Safety notes
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web page of SITRANS FCS400 (www.siemens.com/FCS400) or SITRANS FC410 
(www.siemens.com/FC410).

WARNING
Substitution of components
Substitution of components may impair Intrinsic Safety.

WARNING
Laying of cables
Risk of explosion in hazardous areas.
Cable for use in hazardous areas must satisfy the requirements for having a proof voltage of at 
least 500 V AC applied between the conductor/ground, conductor/shield and shield/ground.
Connect the devices that are operated in hazardous areas as per the stipulations applicable in 
the country of operation.

WARNING
Field wiring installation
Ensure that the national requirements of the country in which the devices are installed are met.

2.4.2 Maximum temperature specifications for Ex use
The maximum dust layer shall be no greater than 5 mm (T5 85°C). 
The apparatus housing shall be connected to the potential equalising conductor in the 
hazardous area. 
The maximum allowable process fluid temperatures with respect to the marked temperature 
class and maximum surface temperature for the device in the following maximum ambient 
temperatures are:

Ta (°C) Maximum Process Temperature per Temperature Class (°C)
T6 T5 T4 T3

60 70 70 70 70
55 85 100 100 100
50 85 100 130 130
45 85 100 135 160
40 85 100 135 190
35 85 100 135 200
30 85 100 135 200
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The maximum allowable process fluid temperatures with respect to maximum surface 
temperatures for hazardous dusts for the device when used with hazardous dusts in the 
following maximum ambient temperatures are: 

Ta (°C) Tprocess max (°C)
 Applications with up to 500 mm dust 

or isolation
Applications with up to 5 mm dust or 

isolation
60 -40 70
55 -10 100
50 20 130
45 50 160
40 80 190
35 110 200
30 140 200

• If Tprocess ≤ 85°C, maximum surface temperature = 85°C
• If Tprocess > 85°C, maximum surface temperature = process temperature
The maximum pressure associated with the process medium in the internal pipes shall be limited 
to 100 bar. 
The equipment internal circuits at the 4-Pin Connection – A, B, 0 and 15 V or Connector X700 
(Pin 1 = 15 V, Pin 2 = 0 V, Pin 3 = A and Pin 4 = B) are not capable of withstanding a 500 V r.m.s. 
a.c. test to earth as required by clause 6.3.13 of IEC 60079-11:2011. This shall be taken into 
account in any equipment installation.
When the equipment is installed as ‘Ex d’, the connector (1/2" NPT or M20) shall be replaced with 
a suitably certified Ex d cable gland or Ex d Conduit Sealing Device and the voltage of the 
equipment shall not exceed 60 V d.c.
If the equipment is installed as flameproof only, it shall not subsequently be installed as 
intrinsically safe unless it can be verified that there has been no damage to the safety 
components within the intrinsically safe circuit on which safety depends by, for example, an 
over-voltage at the supply terminals. The safety components on which intrinsic safety depends 
have been assessed up to an input voltage of 60 V d.c.

Intrinsically safe installations only:
A temporary connection of the SITRANS to an uncertified programming or data download device 
is permitted, when the SITRANS is located in the non-hazardous area (typically prior to 
installation). Alternatively, such a connection may be made when the SITRANS remains in the 
hazardous area, but the area is declared ‘gas-free’. The uncertified programming or data 
download device shall be suitably-approved as a SELV supply to IEC 60950-1, IEC 61010-1 or an 
equivalent standard, with a maximum output voltage of 60 V. The input terminals of the 
SITRANS have a maximum voltage Um = 60V. 
If the equipment is installed as flameproof only, it shall not subsequently be installed as 
intrinsically safe unless it can be verified that there has been no damage to the safety 
components within the intrinsically safe circuit on which safety depends by, for example, a 
voltage above 60 V at the supply terminals. 

Safety notes
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If the Sensor is mounted remotely from the Adapter, the wiring shall be given protection against 
torsional and tensile stresses (e.g. by the use of conduit).

Note
Only installation as Ex ia can be used for installation in Zone 20.

Safety notes
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Description 3
SITRANS Coriolis flowmeter systems consist of a transmitter and a sensor. The following table 
lists the available combinations of transmitters and sensors.

Transmitter Sensor type
FCT010 FCS400

DN 15 to DN 50 (0.5" to 2")

3.1 System integration
The FC410 flowmeter functions as a Modbus RTU slave with standard Modbus commands 
implemented. Setup parameters, process values, diagnostics, and status information are 
mapped as Modbus registers.   
The device can be connected point-to-point or in a multidrop network in non-hazardous or 
hazardous areas. It can be connected to different hosts for example a PLC system or a PC used as 
service tool or configuration tool.  

Note
Multidrop installations in hazardous areas
Multidrop installations in hazardous areas require flameproof conduit seals for each device.

The FCS400 7ME4617-... is preconfigured for integration with the SITRANS FCT070.

3.2 Modbus RTU technology FC410
Modbus RTU is an open serial protocol based on master/slave architecture. The protocol 
interconnects field equipment such as sensors, actuators, and controllers and is widely used in 
both process and manufacturing automation. The fieldbus environment is the base level group 
of digital networks in the hierarchy of plant networks.

Features
The SITRANS F Modbus RTU communication complies with the Modbus Serial Line Protocol. 
Among other things this implies a master / slave protocol at level 2 of the OSI model. A node (the 
master) issues explicit commands to one of the slave nodes and processes responses. Slave 
nodes will not transmit data without a request from the master node, and do not communicate 
with other slaves.
Modbus is a mono master system, only one master can be connected at a time.

SITRANS FC410/FCS400
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Unicast communication mode
In unicast mode (master/slave mode) the master sends a request to a specific slave device and 
waits a specified time for a response. 

Master

response

request

Slave Slave Slave

Figure 3-1 Unicast Mode

Modbus Frame
The Modbus frame is shown below and is valid for both requests and responses.

Table 3-1 Modbus Frame
SLAVE ADDRESS FUNCTION MODE DATA CRC
1 Byte 1 Byte 0 to 252 Bytes 2 Bytes

References
For further information, please refer to the following specification and guidelines available at 
the Modbus Organization  (http://www.modbus.org/) website
1. Serial Line Specification & Implementation guide
2. Application Protocol Specification

3.3 Design
The SITRANS FC410 flowmeter uses the Coriolis principle to measure flow. The device is a one 
channel flowmeter with Modbus RTU RS-485 output.

Description
3.3 Design
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Flowmeter design 
All primary process measurement of mass flow, volume flow, density and process temperature 
are done in the SITRANS FCT010 transmitter.
The SITRANS FCS400 sensor comprises two parallel bent tubes welded directly to the process 
connections at each end via a manifold.
The sensors are available in AISI 316L stainless steel. The sensor enclosure is made of AISI 304 
stainless steel which has a pressure rating related to size.
The sensor enclosure can be equipped with a pressure guard or flushed with dry inert gas at the 
threaded ports for non-hazardous applications only.

Note
Ex certification requires that the threaded ports always remain closed. 

The SITRANS FCT010 transmitter is available in an aluminium enclosure with an ingress 
protection grade of IP67/NEMA 4X. It has a 4-wire M12 cable or terminated cable connection for 
communication and power supply.

Flowmeter overview 

① Transmitter
② Lid-lock
③ Cable feed-through (M12 socket or cable gland)
④ Plug and threaded port for example for pressure guard
⑤ Sensor enclosure
⑥ Process connections

See also
Pressure - temperature ratings (Page 115)

Description
3.3 Design
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3.4 Nameplate layout
Each part of the FC410/FCS400 Coriolis flowmeter has 3 nameplate types showing the following 
information: 
• product identification
• product specifications
• certificates and approvals

Note
Identification
Identify your device by comparing your ordering data with the information on the product 
and specification nameplates.

FC410: Nameplate with general information 

2

1

3

45

6

7

8

SIEMENS

① SITRANS FC410 Product name
② FW Firmware version
③ HW Hardware version
④ Manufacturer Manufacturer name and location
⑤ Country Manufacturing country
⑥ Address range Modbus device address range
⑦ Communication Communication: Modbus Master/Slave RTU technology
⑧ Power Supply Power supply

Description
3.4 Nameplate layout
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FCS400 sensor: Nameplate with general information 

① SITRANS FCS4001) Product name
② Serial no. Sensor serial number
③ Sen. RS Mechanical sensor version number
④ Size DN Size
⑤ Manufacturer Manufacturer name and location
⑥ Country Manufacturing country
⑦ Sensor order no. Sensor replacement order number
⑧ System order no. Flowmeter system order number (transmitter and sensor)
1) With remote versions, the transmitter is identified as 'SITRANS FCT070' and the sensor as 'SITRANS 
FCS400'.

Flowmeter serial number construction
The flowmeter serial number is constructed as follows:
PPYMDDxxxxxx
where
PP = Production factory (Siemens S.A.S. Haguenau: N1)
Y = Production year (for encryption, see below)
M = Production month (for encryption, see below)
DD = Production day (for encryption, see below)
xxxxxx = Sequential number
Encryption:

Calendar year (Y) Code
1950, 1970, 1990, 2010 A
1951, 1971, 1991, 2011 B
1952, 1972, 1992, 2012 C
1953, 1973, 1993, 2013 D
1954, 1974, 1994, 2014 E
1955, 1975, 1995, 2015 F
1956, 1976, 1996, 2016 H (G)
1957, 1977, 1997, 2017 J
1958, 1978, 1998, 2018 K
1959, 1979, 1999, 2019 L

Description
3.4 Nameplate layout
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1960, 1980, 2000, 2020 M
1961, 1981, 2001, 2021 N
1962, 1982, 2002, 2022 P
1963, 1983, 2003, 2023 R
1964, 1984, 2004, 2024 S
1965, 1985, 2005, 2025 T
1966, 1986, 2006, 2026 U
1967, 1987, 2007, 2027 V
1968, 1988, 2008, 2028 W
1969, 1989, 2009, 2029 X
Month (M) Code
January 1
February 2
March 3
April 4
May 5
June 6
July 7
August 8
September 9
October O
November N
December D
Day (DD) Code
Day 1 to 31 01 to 31 (corresponding to the actual date)

Description
3.4 Nameplate layout
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FCS400 sensor: Nameplate with specific information 

12 11

4

5

6

10

7

8

9

1 2 3

① EX approvals Ex approval specifications
 II: Group II  

1/2: category 1/2 (On 
Zone 0)

 

G: for gas  
Ex: for use in explosive 

atmosphere
 

db: type of protection 
flame proof

 

IIC: Gas group  
T4: temperature class  
Ga/
Gb:

Protection level  

② Consult the operating instructions
③ Year of manufacture Manufacturing year

More detailed manufacturing date information is given in the serial 
number found on the identification nameplate

④ Cal. factor Calibration factor
⑤ qm (min) Minimum flow with water at 20 °C (68 °F)
⑥ qm (nom) Nominal flow with water at 20 °C (68 °F)
⑦ IS Power supply
⑧ Enclosure Degree of protection
⑨ Tamb. Ambient temperature range
⑩ Accuracy Accuracy for mass flow and density
⑪ 2813 Notified Body ID (ATEX, example)
⑫ CE CE mark

Note
Approval identifications
Approval certificates and notified body identifications are available for download at siemens.com

Description
3.4 Nameplate layout
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FCS400 sensor: Nameplate with approval information 

① QR code Product-specific QR code
② C✓ C-tick logo
③ WEEE symbol, see Disposal (Page 90)

Note
Logos and warnings
Logos and warnings are only shown on the product where applicable. The combination shown 
in the example above is relevant for a hygienic sensor.
The Australian C-tick mark is mandatory on all products. 

Sensor EHEDG and 3A nameplate

These nameplates appear on all Hygienic sensors 7ME461.-.2...-.....

QR code

With the use of a smart phone, the QR code provides a direct link to
• the product support portal, which includes access to the "How to Install" YouTube video
• the product and production-specific documentation maintained in the production database.

Description
3.4 Nameplate layout
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3.5 Features
• The flowmeter can be used as Modbus slave in stand-alone or parallel operation on Modbus 

or third party automation systems
• Compact sensor design 
• NAMUR conforming sensor built-in lengths (on request) 
• High immunity against process noise
• Fast response to step changes in flow
• High update rate (100 Hz) on all process values
• Measurement of:

– Mass flow
– Volume flow
– Density
– Medium temperature
– Frame temperature

• Independent low flow cut-off settings for mass flow and volume flow
• Automatic zero point adjustment (initiated by host system)
• Process noise damping using digital signal processing (DSP).
• One totalizer for summation of mass flow. The totalizer is reset on loss of power.
• Empty tube monitoring
• Simulation of process values:

– Mass flow
– Volume flow
– Density
– Medium temperature
– Frame temperature

• Troubleshooting and sensor checking
• Use in hazardous areas according to specification
• Intelligent filtering system for aerated flow
• Unit selection of process values and totalizer

3.6 Applications
The main applications of the Coriolis flowmeter can be found in all industries, such as: 
• Chemical & Pharma: detergents, bulk chemicals, acids, alkalis, pharmaceuticals
• Food & Beverage: dairy products, beer, wine, soft drinks, fruit juices and pulps, bottling, CO2 

dosing, CIP/SIP-liquids, mixture recipe control

Description
3.6 Applications
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• Automotive: fuel injection nozzle & pump testing, filling of AC units, engine consumption, 
paint robots

• Oil & Gas: filling of gas bottles, furnace control, test separators, bore-hole plasticizer dosing, 
water-cut metering

• Water & Waste Water: dosing of chemicals for water treatment

3.7 Approvals
Note
For further details see Certificates and approvals (Page 109).

The device is available with approvals for general purpose and for hazardous areas. In all cases, 
check the nameplate on your device, and confirm the approval rating.

Description
3.7 Approvals
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Installing/mounting 4

Note
The weight of the sensors > DN25 is exceeding 18 kg. It takes two persons to safely lift this part 
or unit.

4.1 Basic safety notes

CAUTION
Hot surfaces resulting from hot process media
Risk of burns resulting from surface temperatures above 65 °C (149 °F). 
• Take appropriate protective measures, for example contact protection.
• Make sure that protective measures do not cause the maximum permissible ambient 

temperature to be exceeded. Refer to the information in Technical data (Page 103).

WARNING
Wetted parts unsuitable for the process media
Risk of injury or damage to device. 
Hot, toxic and corrosive media could be released if the wetted parts are unsuitable for the 
process medium. 
• Ensure that the material of the device parts wetted by the process medium is suitable for the 

medium. Refer to the information in Technical data (Page 103).

Note
Material compatibility
Siemens can provide you with support concerning selection of sensor components wetted by 
process media. However, you are responsible for the selection of components. Siemens accepts 
no liability for faults or failures resulting from incompatible materials.

SITRANS FC410/FCS400
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WARNING
Unsuitable connecting parts
Risk of injury or poisoning. 
In case of improper mounting, hot, toxic, and corrosive process media could be released at the 
connections.
• Ensure that connecting parts (such as flange gaskets and bolts) are suitable for connection 

and process media.

WARNING
Exceeded maximum permissible operating pressure
Risk of injury or poisoning.
The maximum permissible operating pressure depends on the device version, pressure limit 
and temperature rating. The device can be damaged if the operating pressure is exceeded. Hot, 
toxic and corrosive process media could be released.
Ensure that maximum permissible operating pressure of the device is not exceeded. Refer to 
the information on the nameplate and/or in Technical data (Page 103).

WARNING
Unprotected cable ends
Risk of explosion through unprotected cable ends in hazardous areas.
• Protect unused cable ends in accordance with IEC/EN 60079-14.

WARNING
Incorrect mounting at Zone 0
Risk of explosion in hazardous areas.
• Ensure sufficient tightness at the process connection.
• Observe the standard IEC/EN 60079-14.

WARNING
Loss of explosion protection
Risk of explosion in hazardous areas if the device is open or not properly closed.
• Close the device as described in Installing/mounting (Page 29).

Installing/mounting
4.1 Basic safety notes
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CAUTION
External stresses and loads
Damage to device by severe external stresses and loads (e.g. thermal expansion or pipe 
tension). Process media can be released.
• Prevent severe external stresses and loads from acting on the device.

DANGER
Pressure applications
Danger to personnel, system and environment will result from improper disassembly.
• Never attempt to loosen, remove, or disassemble process connection while vessel contents 

are under pressure.

4.1.1 Installation location requirements

NOTICE
Aggressive atmospheres
Damage to device through penetration of aggressive vapors.
• Ensure that the device is suitable for the application.

NOTICE
Direct sunlight
Damage to device.
The device can overheat or materials become brittle due to UV exposure.
• Protect the device from direct sunlight.
• Make sure that the maximum permissible ambient temperature is not exceeded. Refer to 

the information in Operating conditions (Page 108).

Installing/mounting
4.1 Basic safety notes
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4.1.2 Proper mounting

NOTICE
Incorrect mounting
The device can be damaged, destroyed, or its functionality impaired through improper 
mounting.
• Before installing ensure there is no visible damage to the device.
• Make sure that process connectors are clean, and suitable gaskets and glands are used.
• Mount the device using suitable tools. Refer to the information in Construction (Page 105).

WARNING
High pressure hazard
In applications with working pressures/media that can be dangerous to people, surroundings, 
equipment or others in case of pipe fracture, we recommend that special precautions such as 
special placement, shielding or installation of a pressure guard or a safety valve are taken when 
the flowmeter is mounted.       

4.2 Installation instructions

4.2.1 Sensor installation

CAUTION
Electromagnetic fields
Do not install the flowmeter in the vicinity of strong electromagnetic fields, for example near 
motors, variable frequency drives, transformers etc.   

Upstream / downstream
• No pipe run requirements, that is straight inlet/outlet sections, are necessary.
• Avoid long drop lines downstream from the sensor to prevent process media separation 

causing air / vapor bubbles in the tube (min. back pressure: 0.2 bar).
• Avoid installing the flowmeter immediately upstream of a free discharge in a drop line.

Installing/mounting
4.2 Installation instructions
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Location in the system 
The optimum location in the system depends on the application: 
• Liquid applications

Gas or vapor bubbles in the fluid may result in erroneous measurements, particularly in the 
density measurement.
– Do not install the flowmeter at the highest point in the system, where bubbles will be 

trapped.
– Install the flowmeter in low pipeline sections, at the bottom of a U-section in the pipeline.

 

Figure 4-1 Liquid applications, wrong location with trapped air/gas
• Gas applications

Vapor condensation or oil traces in the gas may result in erroneous measurements.
– Do not install the flowmeter at the lowest point of the system.
– Install a filter.

 

Figure 4-2 Gas applications, wrong location with trapped oil

Flow direction   
The calibrated flow direction is indicated by the arrow on the sensor. Flow in this direction will 
be indicated as positive by default. The sensitivity and the accuracy of the sensor do not change 
with reverse flow.
The indicated flow direction (positive/negative) is configurable.

CAUTION
Accurate measurement
The sensor must always be completely filled with process media in order to measure accurately.

NOTICE
Orienting the sensor
To avoid water or moist ingress, transmitters should be oriented with cable entrances aiming 
downwards.

Installing/mounting
4.2 Installation instructions
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Orienting the sensor     
The sensor operates in any orientation. The optimal orientation depends on the process fluid 
and the process conditions. Siemens recommends orienting the sensor in one of the following 
ways:
1. Vertical installation with an upwards flow (self-draining)

Figure 4-3 Vertical orientation, upwards flow
2. Horizontal installation, tubes down (recommended for liquid applications)

Figure 4-4 Horizontal orientation, tubes down
3. Horizontal installation, tubes up (recommended for gas applications)

Figure 4-5 Horizontal orientation; tubes up

Note
Hygienic applications
In 3A and EHEDG certified hygienic applications the flowmeter must be installed vertically as 
shown in 1 above.

Installing/mounting
4.2 Installation instructions
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Installation in a drop line is only recommended if a pipeline reduction or orifice with a smaller 
cross-section can be installed to create back-pressure and prevent the sensor from being partially 
drained while measuring. 

① Back pressure orifice
② On / off valve

Figure 4-6 Installation in drop line

4.2.1.1 Mounting the sensor
• Install the sensor in well-supported pipelines in order to support the weight of the flowmeter.
• Center the connecting pipelines axially in order to assure a stress-free installation. The 

flowmeter must not be used to bring the rest of the pipework into line. Make sure the 
pipework is aligned correctly before inserting the flow sensor.

• Install two supports or hangers symmetrically and stress-free on the pipeline closely to the 
process connections.

Note
Handling
Lift the flowmeter by the sensor body. Do not lift the flowmeter by the housing.

Avoid vibrations
• Make sure that any valves or pumps upstream of the sensor do not cavitate and do not send 

vibrations into the sensor.
• Decouple vibrating pipeline from the flow sensor using flexible tube or couplings. 

Installing/mounting
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Figure 4-7 Non-flexible pipes not recommended in vibrating environment

Figure 4-8 Flexible pipes recommended in vibrating environment

Avoid cross talk
When operating more than one flowmeter in one or multiple interconnected pipelines there is 
a risk of cross talk.
Prevent cross talk in one of the following ways: 
• Mount sensors on separate frames
• Decouple the pipeline using flexible tubes or couplings

Figure 4-9 High risk of cross talk when using non-flexible pipes

Figure 4-10 Low risk of cross talk when using flexible pipes and separate frames

Installing/mounting
4.2 Installation instructions
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4.2.1.2 Hydrostatic testing
The flowmeter is pressure-tested before delivery to 1.5 times the rated working pressure of the 
sensor.
• In the case of process connections pressure-rated less than 100 bar, the connection is the 

limiting component. 
• In the case of process connections pressure-rated above 100 bar (stainless steel sensors) or 

above 160 bar (Hastelloy sensors), the sensor is the limiting component.
In all cases the maximum allowed hydrostatic test pressure (MATP) of the flowmeter is 1.5 times 
the marked MAWP (PS) at 20 °C. 
Pressure test of a completed flow system with piping and other components can be done at 
pressures no higher than 1.5 times the marked MAWP (PS) at 20 °C of the lowest rated system 
component. 

4.2.1.3 Installing with insulation
Insulation is added to pipes and equipment for two reasons:
• To protect personnel from exposure to hot or cold surfaces, thereby preventing burns and 

other injuries
• To prevent heat loss into or out of the process, thereby preserving the process temperature 

and process medium conditions.
In both cases, insulation can have the unexpected effect of shrouding other attached 
components not intended or designed for the process temperatures. When installing an FCS400 
sensor with insulation, observe the following rules:
• Do not cover any part of the transmitter pedestal. The pedestal is designed to separate the 

process temperature from the ambient around the DSL or transmitter electronics housing.
• Allow free movement of air around the electronics housing to allow temperature 

equalisation to occur at all times.

4.2.1.4 Pressure guard
The sensor enclosure is supplied with two G½" (parallel thread) purge ports. These ports can for 
example be used for a pressure guard, which can be connected to an automatic shut off valve to 
stop the flow in case of sensor pipe fracture. Because sensor enclosure is rated Ex[d] for 
hazardous applications, the purge ports may not be removed from Ex version sensors.
The AISI 304 / EN 1.4301 exterior enclosure is rated to approximately 20 bar static pressure to 
contain spilt process media in the event of a tube break. However it is not intended to contain 
high pressure or corrosive fluids and precautions must be taken in applications where vibrating 
tube failure is probable and may cause damage. 

Pressure guard selection
Siemens does not supply the components of the pressure guard solution because the 
arrangement and components are closely related to individual safety and protection practices in 
each place. 

Installing/mounting
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The selection of pressure guard solution is the responsibility of the user, however Siemens 
recommends the following forms of pressure guard:
• A pressure switch screwed directly or piped into one of the purge ports and connected to an 

automatic shut-off valve will disable pressurized supply to the meter.
• A relief valve or bursting disc screwed directly or piped to one of the purge ports to carry any 

spilt fluid to drain after opening. Ensure the drain flow is safely contained away from 
personnel and other plant or equipment.

The pressure switch and relief valve set point should be 2-3 bar gauge. The pressure switch 
should be rated to withstand the full process pressure and temperature for a short time without 
rupture.

Mounting of pressure guard
All sensors are filled with argon to avoid condensation. Avoid ingress of moisture, liquids or 
particles into the sensor; it may influence the measurement and in worst case inhibit the 
measuring function.
Install a pressure guard as follows:
1. Place the sensor in a dry, clean place and leave it to acclimatize.
2. Orient the sensor with the purge ports uppermost.
3. Carefully remove the plug and mount the pressure guard. 
4. Replace the soft metal sealing rings with new ones to obtain proper hemetic sealing.
5. Make sure that the pressure guard does NOT touch any of the parts inside the sensor.
6. Check that the pressure guard has been correctly mounted and thoroughly tightened 

(torque: 80 Nm).

Installing/mounting
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4.3 Disassembly

WARNING
Incorrect disassembly
The following risks may result from incorrect disassembly: 
- Injury through electric shock
- Risk through emerging media when connected to the process
- Risk of explosion in hazardous area
In order to disassemble correctly, observe the following:
• Before starting work, make sure that you have switched off all physical variables such as 

pressure, temperature, electricity etc. or that they have a harmless value.
• If the device contains hazardous media, it must be emptied prior to disassembly. Make sure 

that no environmentally hazardous media are released.
• Secure the remaining connections so that no damage can result if the process is started 

unintentionally.

Installing/mounting
4.3 Disassembly

SITRANS FC410/FCS400
Operating Instructions, 06/2020, A5E39789214-AB 39



Installing/mounting
4.3 Disassembly

SITRANS FC410/FCS400
40 Operating Instructions, 06/2020, A5E39789214-AB



Connecting 5
5.1 Basic safety notes

WARNING
Unsuitable cables, cable glands and/or plugs
Risk of explosion in hazardous areas.
• Use only cable glands/plugs that comply with the requirements for the relevant type of 

protection.
• Tighten the cable glands in accordance with the torques specified in Technical data 

(Page 103).
• Close unused cable inlets for the electrical connections.
• When replacing cable glands, only use cable glands of the same type.
• After installation, check that the cables are seated firmly.

WARNING
Incorrect conduit system
Risk of explosion in hazardous areas as result of open cable inlet or incorrect conduit system.
• In the case of a conduit system, mount a spark barrier at a defined distance from the device 

input. Observe national regulations and the requirements stated in the relevant approvals.

NOTICE
Condensation in the device
Damage to device through formation of condensation if the temperature difference between 
transportation or storage and the mounting location exceeds 20 °C (36 °F).
• Before taking the device into operation, let the device adapt for several hours in the new 

environment.

NOTICE
Ambient temperature too high
Damage to cable sheath.
• At an ambient temperature ≥ 60 °C (140 °F), use heat-resistant cables suitable for an 

ambient temperature at least 20 °C (36 °F) higher.
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WARNING
Improper power supply
Risk of explosion in hazardous areas as result of incorrect power supply.
• Connect the device in accordance with the specified power supply and signal circuits. The 

relevant specifications can be found in the certificates, in Technical data (Page 103) or on 
the nameplate.

WARNING
Lack of equipotential bonding
Risk of explosion through compensating currents or ignition currents through lack of 
equipotential bonding.
• Ensure that the device is potentially equalized.
Exception: It may be permissible to omit connection of the equipotential bonding for devices 
with type of protection "Intrinsic safety Ex i".

WARNING
Unprotected cable ends
Risk of explosion through unprotected cable ends in hazardous areas.
• Protect unused cable ends in accordance with IEC/EN 60079-14.

WARNING
Improper laying of shielded cables
Risk of explosion through compensating currents between hazardous area and the 
non‑hazardous area.
• Shielded cables that cross into hazardous areas should be grounded only at one end.
• If grounding is required at both ends, use an equipotential bonding conductor.

WARNING
Incorrect selection of type of protection
Risk of explosion in areas subject to explosion hazard.
This device is approved for several types of protection. 
1. Decide in favor of one type of protection.
2. Connect the device in accordance with the selected type of protection.
3. In order to avoid incorrect use at a later point, make the types of protection that are not used 

permanently unrecognizable on the nameplate.

Connecting
5.1 Basic safety notes
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Note
Electromagnetic compatibility (EMC)
You can use this device in industrial environments, households and small businesses.
For metal enclosures there is an increased electromagnetic compatibility compared to high-
frequency radiation. This protection can be increased by grounding the enclosure.

See also
Connecting (Page 41)

Note
Improvement of interference immunity
• Lay signal cables separate from cables with voltages > 60 V.
• Use cables with twisted wires.
• Keep device and cables at a distance from strong electromagnetic fields.
• Take account of the conditions for communication specified in the Technical data (Page 103).
• Use shielded cables to guarantee the full specification according to HART/PA/FF/Modbus/

EIA-485/Profibus DP.

Use in hazardous areas
Before accessing the sensor terminal compartment and application terminal space check that:
• A safe access permission certificate has been issued by plant operations management
• The flow transmitter may not be opened if energized
• All connection leads are potential free

WARNING
Hazardous areas
Observe the type examination certificates or the test certifications applicable in your country 
if you use transmitters as category 1/2 equipment.

WARNING
Commissioning
Only apply power and commission the device after the device has been properly connected 
and, if required, closed. 

Connecting
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5.2 Wiring

Hazardous area applications
Special requirements apply to the location and interconnection of sensor and transmitter. 
See Use in hazardous areas (Page 13).

WARNING
Transmitter enclosure
Before opening the terminal box check that: 
• No explosion hazard exists
• All connection leads are potential free

5.3 Connecting FC410/FCS400

WARNING
Improper handling
The sensor connected to this device can be operated with high pressure and corrosive media. 
Therefore improper handling of the device can lead to serious injuries and/or considerable 
material damage.

The device is optionally provided with a preformed cable terminated with M12 style stainless 
steel weather-proof plugs.
The cable shield is physically and electrically terminated within the body of the plug.
Take care when handling the cable and passing it through cable ducting. The plug is not 
subjected to excessive tension (pulling) as the internal connections may be disengaged.

Note
Never pull the cable by the plug.

1. Connect the device using the supplied 4-wire cable with M12 plug.
Note
Grounding
The sensor cable screen is electrically connected to chassis, only when the M12 plug is 
correctly tightened. 

Connecting
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Terminal number Description Wire color (Siemens cable)
1 15 V Orange
2 0 V Yellow
3 RS-485 / B White
4 RS-485 / A Blue

• Only use cables with at least the same degree of protection as the sensor to install the sensor.
It is recommended to use cables supplied by Siemens.

• Siemens supplied cables can be ordered with M12 plug on one or both ends or without plug.
• To guarantee the IP67 degree of protection, ensure that both ends of the cables are given 

equivalent protection from ingress of moisture.
• For further information on Siemens-supplied cables, see Technical data (Page 103).

WARNING
Cable requirements
Cables must be suitable for the temperature (at least 70 °C) and be flammability-rated to at 
least V-2.

A: Prepare the cable by stripping it at both ends.

Figure 5-1 Cable end
B: Connect wires within the sensor terminal compartment 
1. Remove the lock screw and remove the lid. 
2. Undo the flexible strap. 
3. Disconnect the sensor connection (white plug) from the electronic. 
4. Loosen the mounting screw using a TX10 Torx driver and remove the electronic from the 

housing. 
5. Remove the cap and the ferrule from the cable gland and slide onto the cable. 
6. Push the cable through the open gland and anchor the cable shield and the wires with the 

clamp bar. 
7. Remove the terminal block from the electronic. 

Connecting
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8. Connect the wires to the terminals according to the list below. 

Terminal number Description Wire color (Siemens cable)
1 15 V Orange
2 0 V Yellow
3 RS-485 / B White
4 RS-485 / A Blue

Figure 5-2 Sensor terminal compartment

9. Reinstall the electronic including the mounting screw. 
10.Connect the sensor connection and the sensor cable. 
11.Restore the flexible strap around all wires. 

Connecting
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12.Assemble and tighten the cable gland. 
13.Remove the O-ring from lid. 
14.Reinstate the lid and screw in until the mechanical stop. Wind back the lid by one turn. 
15.Mount the O-ring by pulling it over the lid and tighten the lid until you feel friction from the 

O-ring on both sides. Wind the lid by one quarter of a turn to seal on the O-ring. 
16.Reinstate and tighten the lid lock screw. 

WARNING
Unprotected cable ends
Risk of explosion through unprotected cable ends in hazardous areas.
• Protect unused cable ends in accordance with IEC/EN 60079-14.

5.3.1 Setting the EOL termination DIP switches
It is important to terminate the Modbus RS-485 line correctly at the start and end of the bus 
segment. Impedance mismatch results in reflections on the line which can cause faulty 
communication transmission.
If the device is at the end of the bus segment, it is recommended to terminate the device. The 
following table shows the relation between the DIP switch settings and the permissible 
communication interface set-ups. 

Note
End Of Line (EOL) termination
The FCT010 EOL termination DIP switch is default set to EOL non-active. If the installation 
requires active termination resistors, the DIP switches should be set to the EOL Active state.

CAUTION
Hazardous areas
Only change the DIP switches in hazardous areas when the device is deenergized.
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Location of DIP switch
The DIP switch is located in the electronic as shown below.

FW4 FW3 (before 07/2018)

 

DIP switch settings for communication set-up
DIP switch Com‐
munication set-
up 

Switch 1 Switch 2 Switch 3 Switch 4

EOL active On On On On
EOL not active On On Off Off

NOTICE
Avoid DIP switch settings not mentioned in the table
DIP switch settings not mentioned in the table preceding are not allowed and may reduce 
communication interface reliability.
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Commissioning 6
6.1 Basic safety notes

WARNING
Improper commissioning in hazardous areas
Device failure or risk of explosion in hazardous areas.
• Do not commission the device until it has been mounted completely and connected in 

accordance with the information in Installing/mounting (Page 29).
• Before commissioning take the effect on other devices in the system into account.

WARNING
Commissioning and operation with pending error
If an error message appears, correct operation in the process is no longer guaranteed.
• Check the gravity of the error.
• Correct the error.
• If the error still exists:

– Take the device out of operation.
– Prevent renewed commissioning.

DANGER
Toxic gases and liquids
Danger of poisoning when venting the device: if toxic process media are measured, toxic gases 
and liquids can be released.
• Before venting ensure that there are no toxic gases or liquids in the device, or take the 

appropriate safety measures.

WARNING
Loss of explosion protection
Risk of explosion in hazardous areas if the device is open or not properly closed.
• Close the device as described in Installing/mounting (Page 29).
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WARNING
Opening device in energized state
Risk of explosion in hazardous areas
• Only open the device in a de-energized state.
• Check prior to commissioning that the cover, cover locks, and cable inlets are assembled in 

accordance with the directives.
Exception: Devices having the type of protection "Intrinsic safety Ex i" may also be opened in 
energized state in hazardous areas.

6.2 General requirements
Before commissioning it must be checked that:
• The device has been installed and connected in accordance with the guidelines provided 

in Installing/mounting (Page 29) and Connecting (Page 41).
• Device installed in hazardous areas meets the requirements described in Use in hazardous 

areas (Page 13).

6.3 Remote commissioning with PDM FC410

WARNING
Commissioning and operation with pending error
If an error message appears, correct operation in the process is no longer guaranteed.
• Check the gravity of the error.
• Correct the error.
• If the error still exists:

– Take the device out of operation.
– Prevent renewed commissioning.

SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent tool 
for the configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices and field components. Follow-up installations and additional 
information on SIMATIC PDM are available on the Internet at SIMATIC PDM (www.siemens.com/
simatic-pdm).
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
For information on, for example, how to install and integrate devices, commission the software, 
see Operating Manual 'Help for SIMATIC PDM'. The manual is delivered with SIMATIC PDM 
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software. Once the SIMATIC PDM is installed on your computer you find the manual under: Start 
> All programs > Siemens Automation > SIMATIC > Documentation. Link at our website: 'Help for 
SIMATIC PDM' (https://support.industry.siemens.com/cs/ww/de/view/109482406/en).

Note
Field device parameters
• For a list of parameters and additional information, consult section "Parameter assignment 

FC410 (Page 71)".
• The field device remains in measurement mode during the time you configure the field 

device.

6.3.1 Functions in SIMATIC PDM
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows you 
to display, compare, adjust, verify, and simulate process device data; also to set schedules for 
calibration and maintenance.
Parameters are identified by name and organized into function groups. See Modbus addressing 
model (Page 131) for more details.
See Modbus addressing model (Page 131) for parameters that do not appear in the menu 
structure in SIMATIC PDM.

6.3.2 Commissioning steps
In the following it is described how to commission the device with SIMATIC PDM.     
The steps are divided into the following sections:
1. Initial setup (Page 51) 
2. Adding device to the communication network (Page 53)
3. Configuring a new device (Page 56). 
4. Wizard - Quick start with PDM (Page 57) 
5. Wizard - Zero point adjustment (Page 62)

6.3.3 Initial setup
To ensure that SIMATIC PDM connects properly complete the two processes outlined below:
1. Deactivate buffers
2. Update the Electronic Device Description (EDD)
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Deactivate buffers for RS-485 COM port
This deactivation is required to align SIMATIC PDM with the Modbus modem for Windows® 
operating systems.

Note
You can find support for Windows operating systems here: support.automation.siemens.com 
(http://support.automation.siemens.com)

1. Click "Start" > "Control Panel" to begin configuration.
2. Click on "Hardware and Sound" > "Device Manager".
3. Open "Ports" folder and double-click the COM Port used by the system to open the 

"Communications Port Properties" window.
4. Select the "Port Settings" tab and click the "Advanced" button.
5. If the "Use FIFO buffers" check box is deselected, click to select.
6. Set "Receiver Buffer" and "Transmitter Buffer" to Low (1).

7. Click "OK" to close out. Close all screens and then reboot.

Update the Electronic Device Description (EDD)
You can locate the EDD in the SIMATIC PDM Device Library under "Devices" > "Modbus" > 
"Sensors" > "Flow" > "Coriolis" > "Siemens AG" > "SITRANS FC". Check the downloads on our 
website (www.siemens.com/FC410) to make sure you have the latest version of SIMATIC PDM, 
the most recent Service Pack (SP) and the most recent hot fix (HF).
Installing a new EDD:
1. Download the EDD from our website (www.siemens.com/FC410) and save the zip file to your 

computer.
2. Launch the SIMATIC PDM Device Integration Manager.
3. Browse to the zipped EDD file and select it.
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6.3.4 Adding a device to communication network
Before setting the parameters, it is necessary to configure the transmitter project in PDM. 
1. Add the device to SIMATIC Modbus network: 

– Select "File" > "New".
Type in a project name, for example FC commissioning.

– Go to "View" and select "Process Device Network" view.
– Right-click on the typed in Project name and select "Insert New Object" > "Networks".
– Right-click on "Networks" and "Insert New Object" > "Communication Network".
– Click on "Assign Device Type" and select "Modbus Network".
– Click "OK" two times.

Your PC is now added to the Modbus Network. 
– Right-click on "Modbus Network" and select "Insert New Object" > "Object".
– Click on "Assign Device Type" , and select "Devices" > "Modbus" > "Sensors" > "Flow" > 

"Coriolis" > "SIEMENS AG" > "SITRANS FC".

Commissioning
6.3 Remote commissioning with PDM FC410

SITRANS FC410/FCS400
Operating Instructions, 06/2020, A5E39789214-AB 53



– Click "OK" two times.

Figure 6-1 Assigning Modbus device to network
2. Set up the communication parameters for SIMATIC Modbus network: 

– Select "Networks" > "My computer", right-click on "COM Port Interface" and select "Object 
Properties".
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– Select the "Communication" tab and configure the communication parameters. The 
transmitters default settings are:
 - Transmission rate: 19200 baud 
 - Parity: even

Figure 6-2 Set the COM Port
– Click "OK".

3. Set up the COM interface:
– Select "Modbus Networks". 
– Right-click on the object name "SITRANS FC" and select "Object Properties".
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– Select the "Communication" tab and configure the Modbus address.

Figure 6-3 Set Modbus address
– Click "OK".

6.3.5 Configuring a new device

Note
Configuring device via SIMATIC PDM
• Clicking "Cancel" button during an upload from device to SIMATIC PDM will result in some 

parameters being updated.

1. Check that you have the most recent EDD, and if necessary update it. See Updating the 
Electronic Device Description (EDD) (Page 70).

2. Launch SIMATIC Manager and create a new project for the device. 
3. Open the menu "Device > Operation > Reset > Restore ordered configuration". Select "Yes" 

button and click "OK" to perform a reset to customer ordered settings.
4. After the reset is complete click on “Upload to PG/PC…” to upload the parameters.
5. Configure the device via the quick start wizard. (See Wizard - Quick Start via PDM (Page 57).)
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6.3.6 Wizard - Quick Start via PDM
The Quick Start wizard provides an easy 5-step procedure that configures the device for a simple 
application.
Please consult the SIMATIC PDM operating instructions or online help for details on using 
SIMATIC PDM.

Access level control
The parameters are protected against changes by access level control. To gain access follow this 
procedure:
1. Go to menu "Device" > "Security". 
2. Select "User" and enter the PIN code. 

The default user PIN code is 2457.

Quick Start

Note
- The "Quick Start" wizard settings are inter-related and changes apply only after you click on 
"Apply and Transfer" at the end of step 5 to save settings offline and transfer them to the device.
- Do not use the "Quick Start" wizard to modify individual parameters.
- Click on "Back" to return and revise settings or "Cancel" to exit the "Quick Start".

Launch SIMATIC PDM, open the menu "Device" > "Wizard - Quick Start...", and follow steps 1 to 
5.
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Step 1 - Identification

Note
The layout of the dialog boxes shown may vary according to the resolution setting for your 
computer monitor. The recommended resolution is 1280 x 960.
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1. Click on "Read Data from Device" to upload Quick Start parameter settings from the device to 
the PC/PG and ensure SIMATIC PDM is synchronized with the device.

2. Click on "Next" to accept the default values.

Step 2 - Sensor orientation
Step 2 shows an overview of the various recommended installation orientations depending on 
the application.
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Step 3 - Sensor connection
The transmitter can be ordered with M12 connection or with terminated cable (for example 
conduit connections).

Commissioning
6.3 Remote commissioning with PDM FC410

SITRANS FC410/FCS400
60 Operating Instructions, 06/2020, A5E39789214-AB



Step 4 - Measurement function
Configure the measurement conditions for the selected process variables. Change "Flow 
direction" if necessary.

Step 5 - Summary
Check parameter settings, and click on
• "Back" to return and revise values or
• "Apply" to save settings offline or 
• "Apply and Transfer" to save settings offline and transfer them to the device.
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The message "Quick Start was successful" will appear. Click on "OK".

See also
Configuring a new device (Page 56)

6.3.7 Wizard - Zero Point Adjustment

Note
Preconditions
Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature.
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Performing a zero point adjustment 
1. Flush out the flowmeter until a homogenous flow is established and the tubes are completely 

filled.

Figure 6-4 Best practice zero point adjustment with a by-pass line and two shut-off devices
2. Establish zero flow for example by closing the shut off-valves.
3. Wait 1 to 2 minutes for the system to settle, and then perform zero point adjustment as 

described in the following steps.
4. Select "Device" > "Wizard - Zero Point Adjustment..." from the main menu of SIMATIC PDM to 

perform an automatic zero point adjustment.
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5. It is recommended to use the default settings ("Auto"). If necessary, change the "Zero Point 
Adjustment Settings".

6. Click on "Next".
7. Click on "Perform".
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8. During the process a progress bar is visible.
9. At the end of the zero point adjustment the outcome is displayed as an offset and a standard 

deviation.
Note
If you get an error message after the zero point adjustment, refer to Fault codes and 
corrective actions (Page 92).

The system is now ready for normal operation.

6.3.8 Changing parameter settings using SIMATIC PDM

Note
Clicking on "Cancel" during an upload from device to SIMATIC PDM will result in some parameters 
NOT being updated.

Many parameters are accessed via the online menus in SIMATIC PDM, see Parameters accessed 
via drop-down menus (Page 66) for the others.
1. Launch SIMATIC PDM, connect to the appropriate device and upload data.
2. Adjust parameter values in the parameter value field.
3. Click on "Enter". 

The status fields read "Changed".
4. Open the menu "Device".
5. Click on "Download to device".
6. In menu "File" click "Save" to save settings offline. 

The status fields are cleared.
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6.3.9 Parameters accessed via drop-down menus
Click on menu "Device" or "View" to open the associated drop-down menus.

Drop-down menus

Table 6-1 Menu "Device"
Option Description
Download to device Download all writable parameters to the device.
Upload to PC/PG Upload all parameters from the device to the parameter

table.
Assign address and TAG Assign communication address and TAG name.
Value comparison Compare values between device / project.
Object Properties Show Properties for device and project.
Calibration log Create calibration logs for field devices.
Change Log The change log records which actions have been per‐

formed with SIMATIC PDM on devices.
Wizard - Quick Start Start guide for quick commissioning of the device.
Wizard - Zero Point Adjustment Start guide for zero point adjustment (automatic and man‐

ual).
Totalizer Show or change totalizer settings.
Maintenance Show maintenance parameters.

Commissioning
6.3 Remote commissioning with PDM FC410

SITRANS FC410/FCS400
66 Operating Instructions, 06/2020, A5E39789214-AB



Option Description
Simulation Start simulation for testing purposes.
Security Select or change access level.
Restore ordered configuration Set all parameters to customer ordered settings.
Communication Show communication settings.

Table 6-2 Menu "View"
Option Description
Process values (online dialog) Show all process values.
Device Diagnostic (online dialog) Show all diagnostics information (alarms and diagnostics 

parameters).
Toolbar (online dialog) Show or hide the toolbar.
Status Bar Show or hide the status bar.
Update Update the content of the active window.

6.3.10 Process values
1. To compare outputs in real time select "View" > "Process values" to see all process values, 

totalizers and loop current.
2. Verify that the process values show the expected values.

Figure 6-5 Process variables

Trend view
Open the menu "View" > "Process values"  and click on one of the "Trend view" buttons to monitor 
the trend of one or all process values available at each tab.
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Operating FC410 7
7.1 Remote operation

For information on Modbus addresses, registers  and function codes see appendix Modbus 
communication FC410 (Page 131).

7.1.1 Overview of device configuration software
There are currently two competing technologies for configuring field devices:
• Electronic Device Description Language (EDDL)-based software
• Field Device Tool / Device Type Manager (FDT/DTM)-based software
From a practical point of view, both EDDL and FDT/DTM solutions do the same thing: provide a 
way of reading and writing configuration parameters to field devices and viewing advanced 
diagnostics.

Note
• SIMATIC PDM (an EDDL-based software) configures a field device using the Electronic Device 

Description (EDD) for that device.
• PACTware and Fieldcare (FDT-based software) use the DTM for that field device.

In addition, there is a new standard called Field Device Integration (FDI) which is a merger of 
these two technologies. Many of the major vendors have stated that their configuration 
software will evolve into being an FDI host. At the time this manual was written, Siemens had 
announced that SIMATIC PDM will become a FDI host system in the near future.

7.1.2 SIMATIC PDM

7.1.2.1 Check SIMATIC PDM version

Procedure
1. Go to SIMATIC PDM Download (http://www.siemens.com/simaticpdm/downloads).
2. Check the support page to make sure you have:

– The latest version of SIMATIC PDM
– The most recent Service Pack (SP)
– The most recent hot fix (HF)
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7.1.2.2 Updating the Electronic Device Description (EDD)

Procedure
1. Check that the EDD revision match the Firmware revision in the device according to the table 

in section Product compatibility FC410 (Page 7).
2. Go to the support page Software downloads (http://www.siemens.com/

processinstrumentation/downloads).
3. Enter the product name in the field "Enter search term...".
4. Download the most current EDD of your device.
5. Save files to your computer in an easily accessed location.
6. Launch SIMATIC PDM – Device Integration Manager.

From the File menu, click "Read device descriptions from compressed source...".
7. Browse to the zipped EDD file, select and open it. 
8. Use the "Integration" function to integrate the EDD into the device catalog. The EDD is now 

accessible via SIMATIC Manager.

7.1.2.3 Set address
Open in SIMATIC PDM the menu Device – Set Address, enter a value for New Address, and click 
on Assign Address.
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Parameter assignment FC410 8
8.1 Functions

8.1.1 Process values
According to standard practice with serial communication the Modbus RTU signal updates 
primary process values and error status values every 10 ms (100 Hz update rate) synchronous 
with the DSP update cycle.

Process value parameters
Default units for process values can be changed, default values are:
• Mass flow (MassflowValue) [kg/s]
• Volume flow (VolumeflowValue) [m3/s]
• Density (Density) [kg/m3]
• Medium temperature (MediumTemp) [°C]
• Sensor frame temperature [°C]
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Process value Modbus register Units
Mass flow 7400 • g/s (grams per second)

• g/min (grams per minute)
• g/h (grams per hour)
• kg/s (kilograms per second) (default)
• kg/min (kilograms per minute)
• kg/h (kilograms per hour)
• kg/d (kilograms per day)
• t/min (metric tons per minute)
• t/h (metric tons per hour)
• t/d (metric tons per day)
• ton/min (short tons per minute)
• ton/h (short tons per hour)
• ton/d (short tons per day)
• ton (UK)/h (long tons per hour)
• ton (UK)/d (long tons per day)
• lb/s (pounds per second)
• lb/min (pounds per minute)
• lb/h (pounds per hour)
• lb/d (pounds per day)
• Custom
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Process value Modbus register Units
Volume flow 7500 • l/s (liters per second)

• l/min (liters per minute)
• l/h (liters per hour)
• m³/s (cubic meters per second) (default)
• m³/min (cubic meters per minute)
• m³/h (cubic meters per hour)
• m³/d (cubic meters per day)
• Ml/d (megaliters per day)
• gal/s (US gallons per second)
• gal/min (US gallons per minute)
• gal/h (US gallons per hour)
• gal/d (US gallons per day)
• bbl-beer/s (beer barrels per second = 31 US gallons)
• bbl-beer/min (beer barrels per minute = 31 US gallons)
• bbl-beer/h (beer barrels per hour = 31 US gallons)·
• bbl-beer/d (beer barrels per day = 31 US gallons)
• bbl/s (oil barrels per second)
• bbl/min (oil barrels per minute)
• bbl/h (oil barrels per hour)
• bbl/d (oil barrels per day)
• ft³/s (cubic feet per second)
• ft³/min (cubic feet per minute)
• ft³/h (cubic feet per hour)
• ft³/d (cubic feet per day)
• gal/s (UK gallons per second)
• gal/min (UK gallons per minute)
• gal/h (UK gallons per hour)
• gal/d (UK gallons per day)
• Mgal/d (US megagallons per day)
• Custom
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Process value Modbus register Units
Density 7600 • µg/l (micrograms per liter)

• µg/m³ (micrograms per cubic meter)
• mg/l (milligrams per liter)
• g/ml (grams per milliliter)
• g/cm³ (grams per cubic centimeter)
• g/l (grams per liter)
• kg/l (kilograms per liter)
• kg/m³ (kilograms per cubic meter) (default)
• lb/in³ (pounds per cubic inch)
• lb/gal (pounds per US gallon)
• lb/ft³ (pounds per cubic foot)
• ton/yd³ (short tons per cubic yard)
• Custom

Temperature 7700 • °C (degrees Celsius) (default)
• °F (degrees Fahrenheit)
• °R (degrees Rankine)
• K (kelvins)

Mass totalizer  • g (grams)
• kg (kilograms)
• t (metric tons)
• ton (short tons)
• ton (UK) (long tons)
• oz (ounces avoirdupois)
• lb (pounds)
• Custom

See also the description of the Zero point adjustment via SIMATIC PDM (Page 62).

Note
Preconditions
Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature.

Note
Change of parameters during zero point adjustment
Do not change any other parameter during the zero point adjustment procedure.

Automatic zero point adjustment 
The device measures and calculates the correct zero point automatically.
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The automatic zero point adjustment of the flowmeter is set by the following parameters:
• Duration (Modbus address 2135)
• Start Zero Point Adjustment (Modbus address 2180)
When zero adjust is initiated by selecting Start Zero Point Adjustment, the mass flow values are 
acquired and totalized for the configured period (Duration). The default zero point adjustment 
period (30 s.) is normally sufficient for a stable zero point measurement. 

Note
Extremely low flow quantity
If the flow quantity is extremely small, extremely precise measurement is necessary. In this case, 
a long zero point adjustment period can be selected for improved zero point adjustment.

Zero point calculation
During zero point adjustment, an average value is automatically calculated using the following 
formula:

Zero point offset value
Average of N flow values
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xi is an instantaneous flow value sampled in 
the time domain
N = Number of samples during zero point ad‐
justment

The offset value must be within the determined Zero Point Offset Limit (Modbus address 2140).

Note
Exceeded zero point offset limit
If the offset value is greater than the configured limit, proceed as follows:
• Check that the tube is completely filled and that the flowrate is absolute zero.
• Check the validity of the configured zero point offset limit.
• Repeat the zero point adjustment.

Zero point standard deviation
After completion of the procedure, the standard deviation is calculated in accordance with the 
following formula:

Zero point standard deviation
Standard deviation of N values
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The standard deviation contains important feedback on the homogeneity of the fluid, for 
example on the presence of bubbles or particles.
The standard deviation must be within the determined Standard deviation limit (Modbus 
address 2138). 

Note
Exceeded standard deviation limit
If the standard deviation is greater than the configured limit, proceed as follows:
• Check that the tube is completely filled and that the flow rate is absolute zero.
• Check that the installation is vibration-free.
• Check the validity of the configure Standard deviation limit (Modbus address 2138). 
• Repeat the zero point adjustment.

Successful automatic zero point adjustment
If the new zero point offset value is valid, it is automatically stored as the new zero point for the 
sensor. It remains stored in the case of a power failure.

Manual zero point adjustment 
In case an automatic zero point adjustment cannot be performed, it is possible to do a manual 
zero point adjustment by entering the zero point offset value.
1. Select Modbus address 2132 Zero Point Adjustment and set the value to 1 = Manual Zero 

Point Adjustment.
2. Select Modbus address 2133 Manual Zero Point Offset and enter the desired offset value. 

8.1.2 Low flow cut-off
In certain applications, for example dosing applications, no flow signals under a certain flow 
level are desired. In these applications, the flow signal can be forced to zero when the flow is 
lower than a predefined flow value (low flow cut-off). 
The transmitter provides two parameters for setting the low flow cut-off:
• Mass flow cut-off limit (Modbus address 2125) 
• Volume flow cut-off limit (Modbus address 2170)
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8.1.3 Empty tube monitoring
The empty tube monitoring function uses the process density for detecting an empty tube. Use 
of this function is recommended for all standard applications.

Note
Gas applications
Deactivate the empty tube monitoring function.

Empty tube monitoring parameters
Two parameters for setting the empty tube monitoring function are available:
• Empty tube detection (Modbus address 2129)
• Empty tube limit (Modbus address 2127)
The empty tube monitoring is activated via the Empty tube detection parameter. When the 
empty tube monitoring function is on, the mass flow / volume flow value is forced to zero if the 
tube is empty.
The tube is defined as empty if the measured density value is lower than the value defined via 
the Empty tube limit parameter.

Note
Process media density
Risk of unintentionally forcing flow values to zero if the difference between the Empty tube limit 
density value and the density of the process media is not sufficient.
• Ensure sufficient difference between the Empty tube limit density value and the process 

media density.

8.1.4 Process noise damping

Noise damping function
The dynamic sensitivity of the flow measurement signal to rapid changes in process flows can 
be reduced by use of the process noise damping function. The function is typically used in 
environment with:
• Strongly pulsating flow
• Changing pump speeds
• Large pressure variations
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Process noise damping settings
Reduce interfering process noise by increasing the setting of the parameter Process noise 
damping (Modbus address 2130).
• Centrifugal pump (1: low)
• Triplex pump (2)
• Duplex pump (3)
• Simplex pump (4)
• Cam pump (5: high)
The default value is Duplex pump. The damping affects all functions and outputs of the sensor.

Centrifugal pump
(1, low)

Triplex pump (2)

 

Duplex pump
(3, default setting)

 

Simplex pump (4)

 

Cam pump (5, 
high)

 

Note
Increased reaction time
The reaction time of the sensor increases when the process noise is damped.

8.1.5 Totalizer

Totalizer function
The device has one totalizer function that can be used to totalize the mass flow process value. 
Default unit of the totalizer can be changed, see Modbus register 8320.
The totalizer may be paused, resumed or reset:
• Pause (Modbus address 2613): the totalizer holds the last value before the failure occurred
• Resume (Modbus address 2614): the totalizer continues counting the actual measured value
• Reset (Modbus address 2612): the totalizer continues counting based on the last input value 

(for example mass flow) before the failure occurred.

Note
The totalizer is reset on power failure.
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8.1.6 Security
All parameters may be viewed but some are protected against changes by access level control. 
The Security menu makes it possible to gain access to PIN code protected parameters and to 
change PIN codes.

The access levels are:
• Read only

Allows no configuration. The user is only able to read the parameter values. No PIN code is 
required. 

• User
Allows configuration and service of all parameters except calibration parameters. Default PIN 
code is 2457. 

Note
Auto Log Off function
The access level will be set to Read only mode if the device is powered off.
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8.1.7 Simulation
Simulation is used for testing purposes, typically for checking that the readings of the control 
system are correct.

Process value simulation
The following process values can be simulated:
• Mass flow (Modbus address 2764)
• Density (Modbus address 2766)
• Medium temperature (Modbus address 2768)
• Sensor frame temperature (Modbus address 2770)
• Volume flow (Modbus address 2772)
The simulation can be activated through SIMATIC PDM in the menu Device → Simulation → 
Process Variables.

8.1.8 Float transmission
The Float Byte Order function ensures that the master and slave use the same sequence of the 
bytes when transmitting float values. This enables the user to configure the transmitter using 
the configuration tool, SIMATIC PDM, and operate the device with all types of PLCs without 
reprogramming the PLC. The transmission order is configured by setting the parameter Byte 
Order in the submenu Device → Communication.

Note
The command Restart Communication must be executed to activate the new byte order 
setting.

This table shows the different options for setting the transmission method:

Selection Sequence
1st 2nd 3rd 4th

1 - 0 - 3 - 2 Byte 1
(MMMMMMMM)

Byte 0
(MMMMMMMM)

Byte 3 
(SEEEEEEE)

Byte 2 
(EMMMMMMM)

0 - 1 - 2 - 3 Byte 0
(MMMMMMMM)

Byte 1
(MMMMMMMM)

Byte 2 
(EMMMMMMM)

Byte 3 
(SEEEEEEE)
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Selection Sequence
1st 2nd 3rd 4th

2 - 3 - 0 - 1 Byte 2
(EMMMMMMM)

Byte 3 
(SEEEEEEE)

Byte 0
(MMMMMMMM)

Byte 1
(MMMMMMMM)

3 - 2 - 1 - 0 * Byte 3
(SEEEEEEE)

Byte 2 
(EMMMMMMM)

Byte 1
(MMMMMMMM)

Byte 0
(MMMMMMMM)

* = Factory setting
S = Sign
E = Exponent
M = Mantissa

NOTICE
Change of float byte order
If the float byte order is changed by use of PDM to anything other than default, all float values 
shown in PDM are wrong.
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Service and maintenance 9
9.1 Basic safety notes

Note
The device is maintenance-free.

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include, for example, check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover
• Reliability of power supply, lightning protection, and grounds

WARNING
Impermissible repair of explosion protected devices
Risk of explosion in hazardous areas
• Repair must be carried out by Siemens authorized personnel only.

WARNING
Dust layers above 5 mm
Risk of explosion in hazardous areas.
Device may overheat due to dust build up.
• Remove dust layers in excess of 5 mm.

NOTICE
Penetration of moisture into the device
Damage to device.
• Make sure when carrying out cleaning and maintenance work that no moisture penetrates 

the inside of the device.
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WARNING
Leaks in the sample gas path
Risk of poisoning. 
When measuring toxic process media, these can be released or collect in the device if there are 
leaks in the sample gas path.
• Purge the device as described in Commissioning (Page 49).
• Dispose of the toxic process media displaced by purging in an environmentally friendly 

manner.

WARNING
Use of a computer in a hazardous area
If the interface to the computer is used in the hazardous area, there is a risk of explosion.
• Ensure that the atmosphere is explosion-free (hot work permit).

9.2 Recalibration
Siemens offers to recalibrate the sensor.
The following calibration types are offered as standard according to configuration:
• Standard mass flow calibration
• Density calibration
• Customer specified mass flow calibration
• Accredited Siemens ISO/IEC 17025 mass flow calibration

Note
SensorFlash
For sensor recalibration the SensorFlash memory unit must always be returned with the 
sensor. 

9.3 Cleaning

Cleaning the enclosure
• Clean the outside of the enclosure with the inscriptions using a cloth moistened with water 

or a mild detergent.
• Do not use any aggressive cleansing agents or solvents, e.g. acetone. Plastic parts or the 

painted surface could be damaged. The inscriptions could become unreadable.
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WARNING
Electrostatic charge
Risk of explosion in hazardous areas if electrostatic charges develop, for example, when 
cleaning plastic surfaces with a dry cloth.
• Prevent electrostatic charging in hazardous areas.

9.4 Maintenance and repair work 

WARNING
Impermissible repair of explosion protected devices
Risk of explosion in hazardous areas
• Repair must be carried out by Siemens authorized personnel only.

WARNING
Maintenance during continued operation in a hazardous area
There is a risk of explosion when carrying out repairs and maintenance on the device in a 
hazardous area.
• Isolate the device from power.
- or -
• Ensure that the atmosphere is explosion-free (hot work permit).

WARNING
Impermissible accessories and spare parts
Risk of explosion in areas subject to explosion hazard.
• Only use original accessories or original spare parts.
• Observe all relevant installation and safety instructions described in the instructions for the 

device or enclosed with the accessory or spare part.
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WARNING
Enclosure open
Risk of explosion in hazardous areas as a result of hot components and/or charged capacitors 
inside the device. 
To open the device in a hazardous area:
1. Isolate the device from power.
2. Visually inspect sensor inlet and outlet.
Exception: Devices exclusively having Intrinsic safety (Ex i) may be opened in an energized 
state in hazardous areas.

WARNING
Hot, toxic or corrosive process media
Risk of injury during maintenance work.
When working on the process connection, hot, toxic or corrosive process media could be 
released.
• As long as the device is under pressure, do not loosen process connections and do not 

remove any parts that are pressurized.
• Before opening or removing the device ensure that process media cannot be released.

WARNING
Improper connection after maintenance
Risk of explosion in areas subject to explosion hazard.
• Connect the device correctly after maintenance.
• Close the device after maintenance work.
Refer to Cables and cable entries (Page 107).

The device is maintenance-free. However, a periodic inspection according to pertinent directives 
and regulations must be carried out.   
An inspection can include check of:
• Ambient conditions
• Seal integrity of the process connections, cable entries, and cover screws
• Reliability of power supply, lightning protection, and grounds

NOTICE
Repair and service must be carried out by Siemens authorized personnel only.

Note
Siemens defines flow sensors as non-repairable products. 
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9.4.1 Maintenance information FC410

Maintenance information parameters
The basic maintenance information parameters are:
• Current date and time
• Operating time total
• Operating time
• Transmitter Hardware version
• Sensor Hardware version

9.4.2 Service information FC410
Service information is information about the condition of the device used for diagnostics and 
service purposes.   

Service information parameters
The basic service information parameters are:
• Driver current
• Pickup 1 amplitude
• Pickup 2 amplitude
• Sensor frequency
• Sensor frame temperature
• Medium temperature
• Zero point adjustment Auto/Manual
• Zero point Offset
• Manual Zero Point
• Zero Point Standard deviation

Service and maintenance
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9.5 Replacing the device

CAUTION
Corrosive substances
Risk of chemical burns when replacing the sensor.
The sensor in the device contains corrosive substances that result in burns on unprotected skin.
• Make sure that the sensor enclosure is not damaged when replacing the sensor.
• If contact with the corrosive substances occurs, rinse the affected skin immediately with 

large amount of water to dilute substance.

9.6 Spare parts/Accessories

9.6.1 Ordering of spare parts
Ensure that your ordering data is not outdated. The latest ordering data is always available on 
the Internet: SIOS catalog Coriolis (https://support.industry.siemens.com/cs/products?
dtp=Catalog&mfn=ps&pnid=17346&lc=de-DE)

9.6.2 Replaceable components
This table gives an overview of which components can be replaced.

Component Order number Photo Replacable in Ex 
devices

Hot swappable 1)

 
SITRANS FC 
Bag of loose parts for sensor 
Contents: 
Screws, O-rings, cable clamp 
parts

A5E03549324 Yes
Observe hazard‐
ous area access 

protocol

No

SITRANS FCT010 
Blind lid in painted aluminum 
small (∅85 mm)
 

A5E03549295 Yes
Observe hazard‐
ous area access 

protocol

Yes
Observe hazardous 
area access proto‐

col

Sensor housing with cable en‐
tries in metric tread

A5E03549313 No No
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Component Order number Photo Replacable in Ex 
devices

Hot swappable 1)

 
Sensor housing with cables en‐
tries in NPT tread

A5E03906080 No No

SITRANS FCS400
M12 option for sensor housing

A5E03906095 No No

Frontend cassette
Spare part frontend cassette 
for FCT010
From firmware 2.X

A5E03549191 No No

Frontend cassette
Spare part frontend cassette 
for FCT010
From firmware 4.0

A5E41526286

1) Components may be replaced while power is on in non-hazardous areas only. 

9.7 Transportation and storage
To guarantee sufficient protection during transport and storage, observe the following:
• Keep the original packaging for subsequent transportation.
• Devices/replacement parts should be returned in their original packaging.
• If the original packaging is no longer available, ensure that all shipments are properly 

packaged to provide sufficient protection during transport. Siemens cannot assume liability 
for any costs associated with transportation damages.
NOTICE
Insufficient protection during storage
The packaging only provides limited protection against moisture and infiltration.
• Provide additional packaging as necessary.

Special conditions for storage and transportation of the device are listed in Technical data 
(Page 103).

9.8 Return procedure
Enclose the bill of lading, return document and decontamination certificate in a clear plastic 
pouch and attach it firmly to the outside of the packaging.
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Required forms
• Delivery note
• Return goods delivery note (http://www.siemens.com/processinstrumentation/

returngoodsnote)
with the following information:
– Product (item description)
– Number of returned devices/replacement parts
– Reason for returning the item(s)

• Decontamination declaration (http://www.siemens.com/sc/declarationofdecontamination)
With this declaration you warrant "that the device/replacement part has been carefully 
cleaned and is free of residues. The device/replacement part does not pose a hazard for 
humans and the environment."
If the returned device/replacement part has come into contact with poisonous, corrosive, 
flammable or water-contaminating substances, you must thoroughly clean and 
decontaminate the device/replacement part before returning it in order to ensure that all 
hollow areas are free from hazardous substances. Check the item after it has been cleaned.
Any devices/replacement parts returned without a decontamination declaration will be 
cleaned at your expense before further processing.

9.9 Disposal

9.9.1 Special disposal required

Note
Special disposal required
The device includes components that require special disposal.
• Dispose of the device properly and environmentally through a local waste disposal 

contractor.

Devices described in this manual should be recycled. They may not be dis‐
posed of in the municipal waste disposal services according to the Directive 
2012/19/EC on waste electronic and electrical equipment (WEEE).
Devices can be returned to the supplier within the EC, or to a locally ap‐
proved disposal service for eco-friendly recycling. Observe the specific reg‐
ulations valid in your country.
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) (https://
support.industry.siemens.com/cs/document/109479891/)
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Diagnostics and troubleshooting FC410 10
10.1 Device status symbols

Device status symbols
SIMATIC PDM/PLC
Sym‐
bol

Device status Priority

Maintenance alarm 1

Cause: Output signal invalid due to fault in the field device or in the peripherals.
Action: Maintenance is required immediately.
 

Manual operation 4

Cause: Output signal temporarily invalid (e.g. frozen) due to work being performed on the device.
Action: Disable manual mode via HMI or engineering system.
 

Process value alarm 8

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-
monitoring, or warnings / faults in the device) indicate that the measured value is unreliable or deviations 
from the set value in the actuators is most likely greater than anticipated under normal operating con‐
ditions. Process or ambient conditions will damage the device or result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
 

 

Process value warning 10

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-
monitoring, or warnings / faults in the device) indicate that the measured value is unreliable or deviations 
from the set value in the actuators is most likely greater than anticipated under normal operating con‐
ditions. Process or ambient conditions can damage the device or result in unreliable output.
Action: Check ambient temperature or process conditions. If possible, install device at different location.
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10.2 Fault codes and corrective actions

10.2.1 Diagnostics

ID Icons Message Cause/Action
36 Sensor supply volt. out of 

range
Contact your local Siemens representative.

37 Sensor supply volt. out of 
range

Contact your local Siemens representative.

38 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

39 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

40 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

41 Temperature measure‐
ment fault

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

42 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

43 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

44 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

45 Flow values not valid Can be due to problems with measured fluid or hardware 
malfunction. If the problem persists, contact your local Sie‐
mens representative.

46 Invalid calibration data Contact your local Siemens representative for recalibration.

47 Invalid compensation data Contact your local Siemens representative.

49 Malfunction in Pickup Am‐
plitude

Contact your local Siemens representative.

50 Malfunction in Pickup Am‐
plitude

Contact your local Siemens representative.

55 Malfunction in sensor driv‐
er

Contact your local Siemens representative.

56 Malfunction in sensor driv‐
er

Contact your local Siemens representative.
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ID Icons Message Cause/Action
57 Malfunction in sensor driv‐

er
Contact your local Siemens representative.

58 Unstable driver oscillation Contact your local Siemens representative.

59 Mass flow out of specifica‐
tion

Reduce the flow. If the problem persists, contact your local 
Siemens representative.

60 Volume flow out of speci‐
fication

Reduce the flow. If the problem persists, contact your local 
Siemens representative.

61 Density out of specifica‐
tion

Contact your local Siemens representative.

62 Fluid temp. below limit Increase the fluid temperature. If the problem persists, con‐
tact your local Siemens representative.

63 Fluid temp. above limit Reduce the fluid temperature. If the problem persists, con‐
tact your local Siemens representative.

64 Frame temp. below limit Increase fluid temperature and check that ambient temper‐
ature is within specified limits. If the problem persists, con‐
tact your local Siemens representative.

65 Frame temp. above limit Reduce fluid temperature and check that ambient temper‐
ature is within specified limits. If the problem persists, con‐
tact your local Siemens representative.

66 Standard Deviation above 
limit

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

67 Zero Point Offset above 
limit

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

68 Zero point adjustment 
failed

Measurement continues with values from last successful 
zero point adjustment. Improve conditions for automatic 
zero point adjustment and repeat adjustment.

69 Empty Tube Limit' excee‐
ded

Make sure that the sensor is filled with liquid and that the 
liquid density is within the specified 'Empty Tube Limit'.

70 Too little fluid in tube Make sure that the sensor is filled with liquid.

71 Parameter storage mal‐
function

Turn off the power, wait 5 seconds and turn on the power 
again. If the problem persists, contact your local Siemens 
representative.

72 Internal error in sensor Contact your local Siemens representative.

73 Internal error in sensor Contact your local Siemens representative.

74 Internal error in sensor Contact your local Siemens representative.

75 Internal error in sensor Contact your local Siemens representative

76 Internal error in sensor Contact your local Siemens representative.
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ID Icons Message Cause/Action
77 Internal error in sensor Contact your local Siemens representative.

78 Unstable measurement 
condition

Check if air is present in the liquid and that the flowmeter is 
operated within its specifications.

79 Auto filtering Check that the flowmeter is operated within its specifica‐
tions. Check other alarms to rule out HW malfunction.

87 Sensor startup Unplug and reconnect the sensor cable. If the diagnostic 
persists after the specified startup time, restart the device. 
If the problem persists, contact Technical Support.

10.2.2 Alarm messages
In the following tables the bits for alarm group 1 and alarm group 2 can be found along with 
possible causes and directions for corrective action.

Alarm group 1 (Modbus address 3012)
Bit Diagnostic Action
4
5

Sensor supply volt. out of range Contact Siemens customer support

6
7
8
9

Temperature measurement fault Contact Siemens customer support

10
11
12
13

Flow values not valid Can be due to problems with measured fluid or hardware malfunction. If the 
failure continues then contact Siemens customer support

14 Invalid calibration data Contact Siemens customer support for recalibration
15 Invalid compensation data Contact Siemens customer support
17
18

Malfunction in Pickup Amplitude Contact Siemens customer support

23
24
25

Malfunction in sensor driver Contact Siemens customer support

26 Unstable driver oscillation Contact Siemens customer support
27 Massflow out of specification Reduce the flow. If the failure continues then contact Siemens customer support
28 Volumeflow out of specification Reduce the flow. If the failure continues then contact Siemens customer support
29 Density out of specification Contact Siemens customer support
30 Fluid temp. below limit Increase the fluid temperature. If the failure continues then contact Siemens 

customer support
31 Fluid temp. above limit Reduce the fluid temperature. If the failure continues then contact Siemens 

customer support
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Alarm group 2 (Modbus adddress 3014)
Bit Diagnostic Action
0 Frame temp. below limit Increase fluid temperature and check that ambient temperature is within speci‐

fied limits. If the failure continues then contact Siemens customer support
1 Frame temp. above limit Reduce fluid temperature and check that ambient temperature is within speci‐

fied limits. If the failure continues then contact Siemens customer support
2 Standard Deviation above limit

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

3 Zero Point Offset above limit

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

4 Zero point adjustment failed

(shown for only 2 seconds)

Measurement continues with values from last successful zero point adjust‐
ment. Improve conditions for automatic zero point adjustment and repeat ad‐
justment. 

5 Empty Tube Limit exceeded Make sure that the sensor is filled with liquid and that the liquid density is within 
the specified Empty Tube Limit

6 The sensor is partially filled Make sure that the sensor is filled with liquid 
7 Parameter storage malfunction Turn off the power, wait 5 seconds and turn on the power again. If the failure 

continues then contact Siemens customer support
8
9
10
11
12
13

Internal error in sensor Contact Siemens customer support

14 Unstable measurement condition Check if air is present in the liquid and that the flowmeter is operated within its 
specifications

15 Auto filtering Check that the flowmeter is operated within its specifications. Check other 
alarms to rule out HW malfunction

23 The sensor is stabilizing Turn off the power, wait 5 seconds and turn on the power again. If the failure 
continues then contact Siemens customer support.

10.3 Operation troubleshooting

10.3.1 Updating the firmware

Note
Firmware update
FW update is to be done only by authorized and trained service personnel.
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1. Contact Technical Support (https://support.industry.siemens.com/cs/my/src?lc=en-WW) to 
receive the latest available firmware bundle.

2. Install the SITRANS FC410 service tool (https://support.industry.siemens.com/cs/ww/en/
view/95197152). Use this tool to download the firmware to the transmitter.

3. Click "Scan network" to connect to your device via the Service tool:

4. Select your device in the "Network scan results" list.
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5. Click on "Configure selected device".

6. Go to the tab "FW update".
7. Click "Load FW file".
8. Select firmware bundle.
9. Click "Start FW update".

10.3.2 Troubleshooting sensor-related problems
Incorrect and unstable measurements, especially at low flows, are typically a result of an 
unstable zero point due to:
• Incorrect installation
• Bubbles in the liquid
• Vibrations or cross talk
• Solid particles settling in the liquid
Follow the 4-step guide to troubleshooting:

Step 1 Preliminary application inspection (Page 98)
Step 2 Zero point adjustment (Page 98)
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Step 3 Measurement error calculation (Page 98)
Step 4 Application improvement (Page 99)
The guide enables you to trace the reason for incorrect measurements and to improve the 
application.

10.3.2.1 Step 1: Inspecting the application
Ensure that:
1. The sensor is installed as described in Installing/mounting (Page 32).
2. The sensor is located in a vibration-free position. Vibrations can disturb the sensor and 

therefore cause measurement error.
Depending on application, you should furthermore ensure the following:
• Liquid application

Ensure that the sensor is filled with liquid and liquid only. 
Air or gas bubbles in the liquid cause instability and can result in measurement errors. 
Flush the pipe systems and the sensor for several minutes at maximum flowrate to remove 
any air bubbles which may be present.
Note
The liquid must be homogeneous in order to measure with high accuracy. If the liquid 
contains solid particles of greater density than the liquid, then these solids can settle, 
especially at low flow rates, which will cause instability in the sensor and lead to 
measurement errors.
For pastes or process fluids with suspended solids always orient the sensor vertically with 
flow in upward direction to maintain solids suspension.

• Gas application
Ensure that the gas pressure/temperature conditions contain sufficient superheat to prevent 
dewing or precipitation. If the gas contains vapor or droplets then these may precipitate, 
causing instability.

10.3.2.2 Step 2: Performing a zero point adjustment
The second step in the troubleshooting procedure is to zero point adjust the device. For further 
information on zero point adjustment, see Remote commissioning with PDM FC410 (Page 50).

10.3.2.3 Step 3: Calculating the measurement error
The result of the zero point adjustment will show you if the zero point was set under good and 
stable conditions. 
The lower the obtained value of the parameter Zero Point Standard Deviation, the lower is the 
achievable measuring error. For a well-installed flowmeter, the Zero Point Standard Deviation 
corresponds to the specified zero point stability for the sensor size, see Performance (Page 103).
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The parameter Zero Point Standard Deviation is located in the Maintenance & Diagnostics 
menu in the SIMATIC PDM.
• The error curve is plotted from the formula:

E = ±    (Cal)2 +  
z x 100

qm(      )
2

E = Error [%]
Z = Zero point [kg/h]
qm = Mass flow [kg/h]
Cal. = Calibrated flow accuracy: 0.10

FSO (sensors 

max. flow rate) 

Error in % of actual mass flow rate with 95% confidence 

(probability)

Actual mass 

flow rate

-1.0

-0.5

1.0

0.5
 0.15
-0.15

50%25%5% 75% 100%

Table 10-1 Reference conditions for flow calibrations (ISO 9104 and DIN/EN 29104)
Flow conditions Fully developed flow profile
Temperature, 
medium

20 °C ± 2 °C (68 °F ± 3.6 °F)

Temperature, 
ambient

20 °C ± 2 °C (68 °F ± 3.6 °F)

Liquid pressure 2 ± 1 bar
Density 0.997 g/cm3
Supply voltage Un ± 1 %
Warming-up 
time

30 min.

Cable length 5 m between transmitter and sensor

10.3.2.4 Step 4: Improving the application
In the following it is described how to find the causes of a high Zero Point Standard Deviation and 
how to improve the installation.

Setting Low flow cut-off
In order to see if the zero point becomes more stable when making changes / adjustments, the 
Low mass flow cut-off (MassFlowCutOff) must be set to 0.0%. 
When Low flow cut-off has been set, it is possible to see the instability directly from the 
massflow in the online window (View → Process Variables)
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This information can be used to troubleshoot. For example, tightening the brackets which hold 
the sensor, or turning off the pump to check if vibrations from the pump are disturbing the 
sensor, etc.

Incorrect installation of the sensor
• Has the sensor been correctly installed, that is fastened to the floor / wall or frame with good 

mounting brackets as shown in the instructions?
Especially for low flowrates, that is flowrates less than 10% of the maximum capacity of the flow 
meter, it is important that the sensor is correctly and stably installed.
If the sensor is not correctly fixed in place, the zero point of the sensor will change, leading to 
measuring errors.
Try to tighten up the sensor brackets to see whether the flow instability is reduced.

Vibrations and cross talk
Vibrations in the pipe system are normally generated by pumps.
Typically, cross talk is generated by two sensors of identical size and positioned in close proximity 
in the same pipe, or installed on the same rail or frame.
Vibrations / cross talk have a greater or lesser effect upon the zero point stability and therefore 
also the measurement accuracy.
1. Check whether there are vibrations.

Turn off the pump and check whether the zero point stability improves, that is if the flowrate 
fluctuation in kg/h is reduced.
If the sensor is disturbed by vibration from the pump or by pressure pulsations, the 
installation should be improved or the pump should be exchanged, for example to another 
type.

2. Check for cross talk.
Turn off the power to the other flow meter(s) and wait approximately 2 minutes, so the 
vibrating tubes in the sensor have stopped vibrating. Then check if the zero point stability has 
improved, that is that the fluctuation in kg/h has been reduced. If this is the case, the sensors 
disturb one another and the installation should be improved.

Air in the liquid
When air is present in the liquid, the zero point becomes unstable, which leads to a poor 
measurement accuracy.
Checking for air:
• Check the Driver Current (View → Device Diagnostics → Advanced Diagnostic)
• Check if the Driver Current varies more than ±1 mA. If this is the case, it is usually due to the 

presence of air or gas bubbles in the liquid.
• Increase the pressure in the sensor, creating a large back pressure upon the sensor by 

reducing the opening of the outlet valve or by increasing the pump pressure. Thereby the size 
of air bubbles inside the sensor will be minimized. If the Driver Current value increases and / 
or the stability of the Driver Current decreases, it is proof that the liquid contains air or gas 
bubbles.
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Typical causes of air in the liquid
• The entry pipe and sensor have not been properly filled with liquid. 
• The pump cavitates, the rotary speed of the pump is too high in relation to the supply of liquid 

to the pump.
• The flow rate in the pipe is too high, so components sitting in front of the flowmeter can 

cause cavitation.
• If there is a filter installed before the flowmeter, it may be close to blocking, which also can 

cause cavitation.
• Liquid flashes to vapor bubbles while  passing through partially open valves or orifices.
• The piping on the pump suction side, pump gaskets or the pump itself is not tight. Air gets 

sucked into the system due to a low pressure on the pump suction side.

Solid particles in the liquid
If the solid particles in a liquid have a density higher than that of the liquid, they can precipitate 
inside the sensor and cause instability which leads to a measurement error.
If solid particles are present in the liquid, they must be homogeneously distributed and have 
similar density as the liquid. Otherwise they can cause relatively large measurement errors.
It is important that the sensor is installed such that solid particles can easily run out of the sensor. 
1. Ensure that the sensor is installed vertically with an upwards flow.
2. Check if solid particles are present in the liquid:

Take a sample of the liquid, fill a glass and see if the solids precipitate.

10.4 Diagnosing with PDM
SIMATIC PDM is a suitable tool for diagnosing the device. 
You can use SIMATIC PDM to read all available parameters to a table for analyzing offline, view 
online/actual process values and online/actual diagnostic information.

Requirements
The following procedure must be completed before diagnosing:
• Installation of PDM and PDM device driver 
• Connection of communications or digital communications interface
Refer to SIMATIC PDM (Page 69).
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Technical data 11
Note
Device specifications
Siemens makes every attempt to ensure the accuracy of these specifications but reserves the 
right to change them at any time.

11.1 Power
Table 11-1 Power supply
Description Specification
Supply voltage [V] 12 - 27 VDC

Um: 60 VDC
 for Ex d, t 12 - 24 VDC
Reverse polarity protection Yes
Power consumption 1.1 W

Specification in case of Intrinsic safety power supply: Ui: 20 V, Ii: 484 mA, Pi: 2.3 W, Li: 0.6 uH, 
Ci: 1.9 nF.

11.2 Performance
Table 11-2 Reference conditions
Description Specification
Process media Water
Process media temperature 20 °C (68 °F)
Ambient temperature 25 °C (77 °F)
Process media pressure 2 bar (29 psi)
Process media density 0.997 g/cm3 (62.2 lb/ft3)
Reference device orientation Horizontal installation, tubes down, flow in direction of ar‐

row on casing, see Installing/Mounting (Page 29).
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Table 11-3 Mass flow accuracy
Specification Unit Sensor size
  DN15 DN25 DN50
Qmin - minimum flowrate kg/h

(lb/min)
20
(0.735)

200
(7.35)

750
(27.6)

Qnom - nominal flowrate kg/h
(lb/min)

3700
(136)

11500
(423)

52000
(1910)

Qmax - maximum flowrate kg/h
(lb/min)

6400
(235)

17700
(650)

70700
(2598)

Max. zero point stability kg/h ±0.2 ±2.0 ±7.5
Measuring accuracy % ±0.1 ±0.1 ±0.1
Repeatability error % ±0.05 ±0.05 ±0.05

Table 11-4 Density accuracy (liquids)
Specification Unit Sensor size
  DN15 DN25 DN50
Density accuracy, standard calibration kg/m³ ±5 ±5 ±5
Density accuracy, extended calibration kg/m³ ±0.5 ±0.5 ±0.5
Density repeatability kg/m³ ±0.25 ±0.25 ±0.25
Density, media pressure effect (kg/m³)/bar ±0.5 ±0.25 ±0.25
Density, media temperature effect (kg/m³)/°C ±0.1 ±0.1 ±0.1

Table 11-5 Media temperature accuracy
Specification Unit Sensor size
  DN15 DN25 DN50
Media temperature accuracy °C ±1 ±1 ±1
Media temperature repeatability °C ±0.25 ±0.25 ±0.25

Table 11-6 Additional error by deviations from reference conditions
Specification Unit Sensor size
  DN15 DN25 DN50
Effect of process pressure % of actual 

flowrate per 
bar

<-0.015 <-0.015 <-0.015

Effect of process pressure at nominal flowrate (kg/h) per bar -0.56 -1.73 -7.8
Effect of ambient temperature:
Display/Frequency/Pulse/Communication output

%/K actual flow‐
rate

< ±0.003 < ±0.003 < ±0.003

Effect of power supply fluctuations  None
Effect of media temperature (kg/h)/°C ±0.0875 ±0.175 ±1.05
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11.3 Construction
Table 11-7 Designated use     
Description Specification
Measurement of process media • Fluid Group 1 (suitable for dangerous fluids)

• Aggregate state: Paste/light slurry, liquid and gas

Table 11-8 Function and system design   
Description Specification
Measuring principle Coriolis
System architecture • Point-to-point  (1 Modbus RTU master - 1 trans‐

mitter slave)
• Multidrop (1 Modbus RTU master - up to 32 

transmitter slaves per segment. Max 247 slaves)

The FCS400 7ME4617-... is preconfigured for integration with the SITRANS FCT070.

Table 11-9 Installation torques   
Description Torque (Nm)
Pressure guard fittings
G 1/4 inch

 
80

Pedestal lock screw cap 10
Cable gland to housing (Siemens supplied, metric) 10

Note
NPT glands
When using NPT glands, user must take care when packing threads and installing cables that 
sufficient tightness is obtained to prevent ingress of moisture.
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11.4 Sensor design
Description Specification
Dimension and weight See "Sensor dimensions" (Page 119)
Process connectors • EN1092-1 B1, PN16, PN40, PN63, PN100, PN160*

• EN1092-1 D (gasket groove), PN40, PN63, PN100, PN160*
• ISO 228-1 G male pipe thread
• ASME B1.20.1 NPT male pipe thread
• ASME B16.5, Cl 150, Cl 300, Cl 600, Cl 900
• DIN 11851**
• DIN 32676
• DIN 11864-1A**, DIN 11864-2C (inch)**, DIN 11864-3A**
• ISO 2852**
• ISO 2853**
• JIS B 2220, 10K, 20K, 40K, 62K

Electrical connection • M12 connector with 4-wire cable
• Standard cable with polymer / brass / stainless steel cable 

glands (metric or NPT)
• Conduit entries (metric or NPT)

Material  
 Measuring tubes • AISI 316L / EN1.4404
 Process connectors • Standard: 

– AISI 316L / EN1.4435 or EN1.4404
• Hygienic:

– AISI 316L / EN1.4435
 Sensor enclosure AISI 304 / W1.4301
 DSL enclosure Aluminum with corrosion-resistant coating
Measuring tube design Split flow through 2 parallel tubes with combined cross-section 

area 50% of the nominal pipe
The measuring tubes are bent in a trapezoidal curve

Measuring tube surface roughness • Standard: 1.6 µm
• Hygienic: 0.8 μm

Self-draining design Yes, when mounted vertically

*: Pressure ratings max. 100 bar
**: Pressure ratings depend on process connection dimension

Technical data
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11.5 Basic electrical requirement for master system
Table 11-10 Power unit   
Description Specification
Protection class Class I (EN60950)
Galvanic isolation primary/secondary SELV acc. to EN 60950 and EN 50178 or equivalent
Master/Receiver Isolation 500 VAC

11.6 Cables and cable entries
The following information applies to cables and cable glands supplied as accessories to the 
device.

Table 11-11 Power and signal cable, basic data   
Description Specification
Number of conductors 4
Square area [mm2] 0.326 (AWG 22/7)
Screen Common shield for all 4 conductors
Outside color Gray (RAL 7001)
External diameter [mm] 6.5
Maximum length 600 m (1968 ft.)
Installation environment Industrial including chemical processing plants
Insulation material Special polyolefin
Halogen-free Yes
RoHS compliant Yes
Torsional strength • >3 million cycles at ± 180° on 200 mm

• Not adapted for garland mounting (festoon)
Permissible temperature range [°C (°F)] -40 to +80 (-40 to +176)
Min. bending radius allowed Single 5 X ø

Technical data
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Table 11-12 Cable glands and entries
Description Specification
Glands • Material

– Nylon1)

– Brass/Ni plated
– Stainless steel AISI 316/1.4404

• Cable cross section
– ∅ 5 to 10 mm (0.20" to 0.39")

Entry • 1 x M20 or 1 X NPT ½" for communication
1): If operating temperature is below -20 °C (-4 °F), use Brass/Ni plated or stainless steel cable 
glands.

Note
For hygienic applications (3A & EHEDG) the cable glands and blind plugs must be made from 
corrosion resistant material like nickel brass, stainless steel or plastic. The exposed threads must 
be minimized when they are tightened up on the cable and they must have a seal (plastic or 
rubber) under the threads where they screw into the terminal housing or enclosure.

11.7 Operating conditions
Table 11-13 Basic conditions   
Description Specification
Ambient temperature (°C[°F])
(Humidity max. 90 %)

Operation -40 to +60 [-40 to +140]

Ambient temperature (°C[°F]) 
(Humidity max. 90 %)

Storage -40 to +70 [-40 to +158]

Climate class DIN 60721-3-4
Altitude Up to 2000 m (6560 ft)
Relative humidity [%] 95
EMC performance EN/IEC 61326-1 (Industry)

Table 11-14 Cleaning and sterilizing conditions
Description Specification
Cleaning method • CIP

• SIP

Technical data
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Table 11-15 Process media conditions
Description Specification
Process media temperature (Ts) (min to max) [°C (F)]
• DN15 - DN50

 
-50 up to +200 [-58 to 392]

Process media density (min to max) [kg/m3 (lb/ft3] 1 to 5000 (0.06 to 312)
Process media gauge max pressure [bar (psi)] 100 (1450) st. steel
Pressure drop See Pressure drop curves (Page 118) 
Pressure temperature ratings See Pressure - temperature ratings 

(Page 115) 

11.8 Process variables FC410
Description Specification
Primary process variables • Mass flow

• Density
• Medium temperature

Derived process variable • Volume flow

11.9 Approvals note
Note
Device-specific approvals
Always refer to nameplates on the device for device-specific approvals.

11.10 Certificates and approvals
SITRANS FC410/FCS400 flowmeter 
"Intrinsic safety" type of protection  
 ATEX

Sira 11ATEX 1341 X
II 1/2 G Ex db ia IIC T* Ga/Gb
 II 1/2 G Ex db IIC T* Ga/Gb
1D Ex ia IIIC T*°C Da/Db
2D Ex tb IIIC T*°C Db
Ta = -40°C to +*°C
* Temperature class (dependent on the maximum process 
temperature and the maximum ambient temperature, 
see Special conditions for safe use (Page 14))
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SITRANS FC410/FCS400 flowmeter 
 cCSAus (Kanada, USA)

2508644
Ex db ia IIC T6-T3 Gb
Ex tb IIIC T135°C Db
Ex ia IIIC T135°C Da
 
Class I, II, III, Division 1, Groups A, B, C, D, E, F, G
Class I, Zone 1, AEx db ia IIC T6-T3 Gb
Zone 21, AEx tb IIIC T135°C Db
Zone 20, AEx ia IIIC T135°C Da

 Hygienic version • 3A
• EHEDG
• 1935/2004/EC and 2023/2006/EC (food contact ma‐

terial: stainless steel)

See also
Certificates (http://www.siemens.com/processinstrumentation/certificates)

11.11 SensorFlash
Table 11-16 SensorFlash 
Description Specification

Micro SD card
Capacity 4 GB
File system support FAT32 / 8.3
Temperature range
Operation:
Storage:

-40 to +85 °C (-40 to 185 °F)
-40 to +100 °C (-40 to 212 °F)

11.12 Modbus Communication Specification
Table 11-17 Modbus communication specification   
Description Specification
Device type Slave
Baud rates • 9600 

• 19 200 (Factory setting FC410)
• 38 400 
• 57 600 
• 76 800 
• 115 200 (Factory setting FCS400/FCT070)

Technical data
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Description Specification
Number of stations Max. 31 per segment without repeaters
Device address range 1 to 247
Protocol Modbus RTU
Electrical interface RS-485, 2-wire
Connector type M12 or cable termination
Supported function codes • 3: read holding registers

• 16: write multiple registers
• 8: diagnostics

Broadcast No 1)

Maximum cable length [m] 600 meters (@ 115 200 bits/sec)
Standard Modbus over serial line v 1.0 2)

Certification one
Device Profile None

1): Standard restriction. The standard requires a LED indicator for visual diagnosis. This device 
does not support a LED indicator. This device does not react to any Broadcast commands.
2): According to the Specification & Implementation guide v. 1.0 available at the Modbus 
Organization website

Note
Storage location
All Modbus settings of the device are stored in a non-volatile memory.

11.13 PED
The pressure equipment directive 2014/68/EU applies to the alignment of the statutory orders 
of the European member states for pressure equipment. Such equipment in the sense of the 
directive includes vessels, pipelines and accessories with a maximum allowable pressure of 
more than 0.5 bar above atmospheric. Flowmeters are considered as piping.
A detailed risk analysis of the flowmeter has been performed in accordance with the PED 
2014/68/EU. All risks are assessed to be "none" provided that the procedures and standards 
referenced in these operating instructions are observed.

Division according to the danger potential
Flowmeters which are categorized as piping are divided into categories according to danger 
potential (medium, pressure, nominal diameter). The flowmeters fall into the categories I to III 
or they are manufactured according to Paragraph 3 - Sound Engineering Practice (SEP).

Technical data
11.13 PED

SITRANS FC410/FCS400
Operating Instructions, 06/2020, A5E39789214-AB 111



The following criteria are decisive for assessment of the danger potential and are also shown in 
Diagrams 1 to 4, see Diagrams (Page 111).

Fluid group Group 1 or 2
• Aggregate state Liquid or gaseous
• Type of pressur‐

ized equipment
– Pipeline

 
 
Product of pressure and volume (PS * V [barL])

The maximum allowable temperature for the used liquids or gases is the maximum process 
temperature which can occur, as defined by the user. This must be within the limits defined for 
the equipment.

Division of media (liquid/gaseous) into the fluid groups
Fluids are divided according to Article 13 into the following fluid groups:

Group 1 fluids
Explosive
R phrases: for example: 2, 3 (1, 4, 5, 6, 9, 16, 18, 19, 
44)

Very toxic
R phrases: for example: 26, 27, 28, 39 (32)

Extremely flammable
R phrases: for example: 12 (17)

Toxic
R phrases: for example: 23, 24, 25 (29, 31)

Technical data
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Highly flammable
R phrases: for example: 11, 15, 17 (10, 30)

Oxidizing 
R phrases: for example: 7, 8, 9 (14, 15, 19)

Flammable
R phrases: for example11 (10)

 

Group 2 fluids
All fluids not belonging to Group 1.
Also applies to fluids which are for example dangerous to the environment, corrosive, dangerous 
to health, irritant or carcinogenic (if not highly toxic).

Conformity assessment
Flowmeters of categories I to III comply with the safety requirements of the directive. They are 
affixed with the CE mark and an EC declaration of conformity is provided.
The flowmeters are subjected to the conformity assessment procedure - Module H.
Flowmeters according to Article 4 Paragraph 3 are designed and manufactured in accordance 
with sound engineering practice. PED conformity reference is not affixed to the CE mark.
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Diagrams
Gases of fluid group 1
• Pipelines according to Article 4 (a) (i) First dash
• Exception: unstable gases belonging to Categories I and II must be included in Category III.
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Figure 11-1 Diagram 1

Gases of fluid group 2
• Pipelines according to Article 4 (a) (i) Second dash
• Exception: liquids at temperatures > 350 °C belonging to Category II must be included in 

Category III.
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Figure 11-2 Diagram 2
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Liquids of fluid group 1
• Pipelines according to Article 4 (a) (ii) First dash

I

II

III

Article 3

Paragraph 3 

0,1 1 10 100 1000 10000
25

DN

PS = 0,5

PS = 10

PS = 500

4000

1

10

100

1000

0,5

PS [bar]

D
N

 =
 2

5

P
S
 · D

N
 = 2000

500

Figure 11-3 Diagram 3

Liquids of fluid group 2
• Pipelines according to Article 4 (a) (ii) Second dash
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Figure 11-4 Diagram 4

11.14 Pressure - temperature ratings
Pressure - temperature ratings are determined by process connection material and applicable 
standards. The tables below detail the allowed maximum process pressure for sensor variants 
with stainless steel measuring tubes.
With two major exceptions, the pressure rating of the flow sensors is independent of the process 
medium temperature. Design rules for flange connections in both the EN1092-1 and ASME 
B16.5 standards dictate pressure derating with increasing temperature. The charts below show 
the effect of process medium temperature on the pressure ratings for the flanges within the 
product program.
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Note
Maximum sensor operating pressure
The maximum sensor operating pressure is limited to 100 bar.

11.14.1 Stainless steel sensors

Table 11-18 EN1092-1 [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 150 180
16 16.0 16.0 16.0 15.2 13.7 13.1
40 40.0 40.0 40.0 37.9 34.5 32.9
63 63.0 63.0 63.0 59.7 54.3 51.8
100 100.0 100.0 100.0 94.8 86.1 82.1
160 100 (see Note "Maximum sensor operating pressure)

Table 11-19 ISO228-G and ASME B1.20.1 NPT [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 150 200
110 100 (see Note "Maximum sensor operating pressure)

Table 11-20 ASME B16.5 [bar]
Class / Group Temperature TS (°C)

-50 0 50 100 150 200
150 / 2.2 19 19 18.4 16.2 14.8 13.7
300 / 2.2 49.6 49.6 48.1 42.2 38.5 35.7
600 / 2.2 99.3 99.3 96.2 84.4 77.0 71.3
900 / 2.2 100 (see Note "Maximum sensor operating pressure)

Table 11-21 JIS [bar]
PN (bar) Temperature TS (°C)

-50 0 50 120 150 200
10K 14 14 14 14 13.4 12.4
20K 34 34 34 34 33.1 31.6

Technical data
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PN (bar) Temperature TS (°C)
-50 0 50 120 150 200

40K 68 68 68 68 66.2 63.2
63K 100 100 100 100 100 99

Table 11-22 DIN 11851 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
25 / 50-100 25 25 25 25 25
40 / 10-40 40 40 40 40 40

Table 11-23 DIN 32676 & ISO 2852 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
10 / 85-219.1 10 10 10 10 10
16 / 48.3-76.2 16 16 16 16 16
25 / 6.35-42.4 25 25 25 25 25

Table 11-24  ISO 2853 [bar]
PN (bar) / DN Temperature TS (°C)

-50 0 50 100 140
25 / 50-100 25 25 25 25 25
40 / 10-40 40 40 40 40 40

Table 11-25 DIN 11864-1 [bar]
DN Temperature TS (°C)

-50 0 50 100 140
50-80 25 25 25 25 25
15-25 40 40 40 40 40

Table 11-26 DIN 11864-2 [bar]
DN Temperature TS (°C)

-50 0 50 100 140
50-80 16 16 16 16 16
15-25 25 25 25 25 25
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Table 11-27 DIN 11864-3 [bar]
DN Temperature TS (°C)

-50 0 50 100 140
80 16 16 16 16 16
50 25 25 25 25 25
15-25 40 40 40 40 40

Table 11-28 Swagelok SS-12-VCO-3 socket weld with SS-12-VCO-4 nut [bar]
PN (bar) Temperature TS (°C)

-50 0 50 100 150 200
100 100.0 100.0 100.0 100.0 100.0 100.0

Note
Test pressure
Maximum allowable test pressure (MATP) for the flowmeter and process connection is 1.5 times 
the nominal pressure up to 150 bar (2176 psi).

11.14.2 Pressure drop curves
The pressure drop is dimension-dependent and influenced by process media viscosity and 
density. Sensors with undersized process connections experience higher pressure drop due to 
reduction in inlet/outlet dimensions.

Note
Pressure drop information
Pressure drop information is available on request.

Technical data
11.14 Pressure - temperature ratings
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Dimension drawings 12
12.1 Sensor dimensions

Table 12-1 Basic dimensions   
Sensor DN A in mm (inch) B in mm (inch) C in mm (inch) Weight in kg (lb)
15 (½") 90 (3.54) 280 (11.0) 90 (3.54) 4.6 (10.1)
25 (1") 123 (4.84) 315 (12.4) 90 (3.54) 7.9 (17.4)
50 (2") 187 (7.36) 390 (15.4) 90 (3.54) 25.7 (56.7)

Note
The build in length (D) depends on the process connector.
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12.2 316L stainless steel - standard & hygienic
Table 12-2 Sensor sizes DN15, DN25 and DN50
Sensor DN15

(½")
DN25
(1")

DN50
(2")

Connection DN6
(⅛")

DN10
(⅜")

DN15
(½")

DN20
(¾")

DN25
(1")

DN25
(1")

DN32
(1¼")

DN40
(1½")

DN40
(1½")

DN50
(2")

EN1092-1 B1, PN16   265
(10.4)

 265
(10.4)

360
(14.2)

 365
(14.4)

610
(24.0)

610
(24.0)

EN1092-1 B1, PN40   265
(10.4)

 265
(10.4)

360
(14.2)

 365
(14.4)

610
(24.0)

610
(24.0)

EN1092-1 B1, PN63   265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

EN1092-1 B1, PN100   270
(10.6)

 275
(10.8)

360
(14.2)

 365
(14.4)

610
(24.0)

610
(24.0)

EN1092-1 B1, PN160   270
(10.6)

  360
(14.2)

   620
(24.4)

EN1092-1 D, PN40   265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

EN1092-1 D, PN63   265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

EN1092-1 D, PN100   270
(10.6)

  360
(14.2)

  610
(24.0)

610
(24.0)

EN1092-1 D, PN160   270
(10.6)

  360
(14.2)

   620
(24.4)

ANSI B16.5, Class 150   270
(10.6)

270
(10.6)

 360
(14.2)

 365
(14.4)

 620
(24.4)

ANSI B16.5, Class 300   270
(10.6)

270
(10.6)

 360
(14.2)

 380
(15.0)

 620
(24.4)

ANSI B16.5, Class 600   270
(10.6)

285
(11.2)

 360
(14.2)

 380
(15.0)

 620
(24.4)

ANSI B16.5, Class 900   290
(11.4)

  385
(15.2)

   620
(24.4)

ISO 228-1 G male pipe thread 265
(10.4)

 265
(10.4)

  365
(14.4)

   620
(24.4)

ANSI B1.20.1 NPT male pipe 
thread

265
(10.4)

 270
(10.6)

  365
(14.4)

   620
(24.4)

DIN 11851 Hygienic 
screwed 1)

 265
(10.4)

265
(10.4)

 270
(10.6)

360
(14.2)

360
(14.2)

 610
(24.0)

610
(24.0)

DIN 32676-C Hygienic 
clamp 1)

  265
(10.4)

265
(10.4)

 360
(14.2)

 360
(14.2)

 610
(24.0)

DIN 11864-1 Aseptic 
screwed 1)

  265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

Dimension drawings
12.2 316L stainless steel - standard & hygienic
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Sensor DN15
(½")

DN25
(1")

DN50
(2")

Connection DN6
(⅛")

DN10
(⅜")

DN15
(½")

DN20
(¾")

DN25
(1")

DN25
(1")

DN32
(1¼")

DN40
(1½")

DN40
(1½")

DN50
(2")

DIN 11864-2A Aseptic 
flanged 1)

  265
(10.4)

  360 
(14.2)

  620 
(24.4)

610
(24.0)

DIN 11864-3A Aseptic 
clamp 1)

  265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

ISO 2852 Hygienic clamp 1)     265
(10.4)

360
(14.2)

 360
(14.2)

610
(24.0)

610
(24.0)

ISO 2853 Hygienic screwed 1)     265
(10.4)

360
(14.2)

 360
(14.2)

630
(24.8)

610
(24.0)

SMS 1145 Hygienic screwed     265
(10.4)

360
(14.2)

  610
(24.0)

610
(24.0)

12-VCO-4 Quick connect   285
(11.2)

       

JIS B2220 10K   265
(10.4)

  360
(14.2)

  620
(24.4)

610
(24.0)

JIS B2220 20K   265
(10.4)

  360
(14.2)

  620
(24.4)

610
(24.0)

JIS B2220 40K   270
(10.6)

  360
(14.2)

  620
(24.4)

610
(24.0)

JIS B2220 63K   275
(10.8)

  370
(14.6)

   620
(24.4)

Dimensions in mm (inch)
 1) Available with 3A and EHEDG certification. 

Note
3A
DIN 11851 and ISO 2853 are only 3A-approved if self-centering gaskets are used.

12.3 316L stainless steel - NAMUR
Table 12-3 Sensor sizes DN15, DN25 and DN50
Sensor DN15

(½")
DN25
(1")

DN50
(2")

Connection DN6
(⅛")

DN10
(⅜")

DN15
(½")

DN20
(¾")

DN25
(1")

DN25
(1")

DN32
(1¼")

DN40
(1½")

DN40
(1½")

DN50
(2")

EN1092-1 B1, PN40   510
(20.1)

 510
(20.1)

600
(23.6)

 605
(23.8)

715
(28.1)

715
(28.1)

Dimensions in mm (inch)

Dimension drawings
12.3 316L stainless steel - NAMUR
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12.4 316L stainless steel - Hygienic versions
Table 12-4 Sensor sizes DN15, DN25 and DN50
Sensor DN15

(½")
DN25
(1")

DN50
(2")

Connection DN10
(3.8")

DN15
(½")

DN20
(¾")

DN25
(1")

DN25
(1")

DN32
(1¼")

DN40
(1½")

DN40
(1½")

DN50
(2")

DIN 11851 Hygienic screwed 265
(10.4)

265
(10.4)

 270
(10.6)

360
(14.2)

360
(14.2)

 610
(24.0)

610
(24.0)

DIN 32676-C Hygienic clamp  265
(10.4)

265
(10.4)

 360
(14.2)

 360
(14.2)

 610
(24.0)

DIN 11864-1 Aseptic screwed  265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

DIN 11864-2A Aseptic 
flanged

 265
(10.4)

  360
(14.2)

  620
(24.4)

610
(24.0)

DIN 11864-3A Aseptic clamp  265
(10.4)

  360
(14.2)

  610
(24.0)

610
(24.0)

ISO 2852 Hygienic clamp    265
(10.4)

360
(14.2)

 360
(14.2)

610
(24.0)

610
(24.0)

ISO 2853 Hygienic screwed    265
(10.4)

360
(14.2)

 360
(14.2)

630
(24.8)

610
(24.0)

SMS 1145 Hygienic screwed    265
(10.4)

360
(14.2)

  610
(24.0)

610
(24.0)

Dimensions in mm (inch)

Note
3A
DIN 11851 and ISO 2853 are only 3A-approved if self-centering gaskets are used.

Dimension drawings
12.4 316L stainless steel - Hygienic versions
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Product documentation and support A
A.1 Product documentation

Process instrumentation product documentation is available in the following formats: 
• Certificates (http://www.siemens.com/processinstrumentation/certificates)   
• Downloads (firmware, EDDs, software) (http://www.siemens.com/processinstrumentation/

downloads) 
• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs) 
• Manuals (http://www.siemens.com/processinstrumentation/documentation) 

You have the option to show, open, save, or configure the manual.
– "Display": Open the manual in HTML5 format
– "Configure": Register and configure the documentation specific to your plant
– "Download": Open or save the manual in PDF format
– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC

You can also find manuals with the Mobile app at Industry Online Support (https://
support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile device 
and scan the device QR code.

Product documentation by serial number
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates.

Entering a serial number
1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com).
2. Select the desired language.
3. Enter the serial number of your device. The product documentation relevant for your device 

is displayed and can be downloaded.
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.

Scanning a QR code
1. Scan the QR code on your device with a mobile device.
2. Click "PIA Portal".
To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login or 
register.
Certification documents including calibration report are supplied with each sensor included on 
the SensorFlash. Material, pressure test, and factory conformance certificates are optional at 
ordering.
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Note
EAC declaration
The EAC declaration is available on the SensorFlash SD card delivered with the device. 

A.2 Technical support

Technical support
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request). 
Additional information on our technical support can be found at Technical Support (http://
www.siemens.com/automation/csi/service).   

Service & support on the Internet 
In addition to our technical support, Siemens offers comprehensive online services at Service & 
Support (http://www.siemens.com/automation/serviceandsupport).

Contact 
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact (http://www.automation.siemens.com/partner).
To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation".
Contact address for business unit: 
Siemens AG
Digital Industries
Process Automation
Östliche Rheinbrückenstr. 50 
76187 Karlsruhe, Germany

Product documentation and support
A.2 Technical support
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Technical reference B
B.1 Theory of operation

The Coriolis principle of measurement
The flow measurement is based on the Coriolis law of motion. Particles moving in a rotating / 
oscillating system will resist imposed oscillations in a manner consistent with their mass and 
velocity (momentum).
The SITRANS F C sensors are energized by an electromagnetic driver circuit which oscillates the 
pipes at their resonant frequency. Two pickups are placed symmetrically on either side of the 
driver to provide position signals for digital processing.
When the media flows through the sensor, Coriolis force will act on the measuring tubes and 
cause deflection which can be measured as a phase shift between Pickup 1 and Pickup 2. The 
phase shift is proportional to the mass flowrate.

 
 

 

 

 

 

 

à à

The frequency (or period) of the vibration is a direct function of the process media density.
The frequency and amplitude of the driver is regulated to ensure a stable output from the 2 
pickups. The temperature of the sensor tubes is measured to provide accurate compensation for 
changes in the material stiffness. As a result the process media temperature is also accurately 
measured.
The flow proportional phase signal from the pickups, the temperature measurement and the 
driver frequency enable calculation and reporting of mass, density, volume, and temperature.
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Digital signal processing (DSP)
The analog to digital conversion takes place in an ultra low noise sigma delta converter with high 
signal resolution. With fast digital signal processing mass flow and density values are calculated 
using a patented DFT technology (Discrete Fourier Transformation). The combination of this 
patented DFT technology and the fast DSP enables short response time (< 10 ms) to changes in 
the measured values. 
The built-in noise filter is configurable and can be used for improving the performance of the 
flowmeter, in case the installation and application conditions are not ideal. Typical process noise 
such as gas bubbles (two-phase-flow) can be reduced through the filter functions.

B.2 Sensor dimension dependent default settings

B.2.1 Mass flow

FCS400 
Sensor size Default value kg/s
Upper alarm limit and Upper warning limit
DN 15 2.209
DN 25 6.136
DN 50 24.54
Lower alarm limit and Lower warning limit
DN 15 -2.209
DN 25 -6.136
DN 50 -24.54

Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DN 15 0.0103 37.08
DN 25 0.0319 114.84
DN 50 0.1444 519.84

Technical reference
B.2 Sensor dimension dependent default settings

SITRANS FC410/FCS400
126 Operating Instructions, 06/2020, A5E39789214-AB



B.2.2 Volume flow

FCS400 
Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DN 15 0.0225
DN 25 0.0626
DN 50 0.250
Lower alarm limit and Lower warning limit
DN 15 -0.0225
DN 25 -0.0626
DN 50 -0.250

Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DN 15 0.000010278 0.037
DN 25 0.000031944 0.115
DN 50 0.000144444 0.52

B.2.3 Standard volume flow

FCS400 
Sensor size Default value m3/s
Upper alarm limit and Upper warning limit
DN 15 0.0225
DN 25 0.0626
DN 50 0.250
Lower alarm limit and Lower warning limit
DN 15 -0.0225
DN 25 -0.0626
DN 50 -0.250

Sensor size Default value m3/s Default value m3/h
Low flow cut-off
DN 15 0.000010278 0.037
DN 25 0.000031944 0.115
DN 50 0.000144444 0.52

Technical reference
B.2 Sensor dimension dependent default settings
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B.2.4 Fraction

FCS400 
Sensor size Unit Default value
Upper alarm limit and Upper warning limit
DN 15 Mass flow kg/s 2.209

Volume flow m3/s 0.0225
DN 25 Mass flow kg/s 6.136

Volume flow m3/s 0.0626
DN 50 Mass flow kg/s 24.54

Volume flow m3/s 0.250
Lower alarm limit and Lower warning limit
DN 15
 

Mass flow kg/s -2.209
Volume flow m3/s -0.0225

DN 25
 

Mass flow kg/s -6.136
Volume flow m3/s -0.0626

DN 50 Mass flow kg/s -24.54
Volume flow m3/s -0.250

B.2.5 Zero point adjustment

FCS400 
Sensor size Default value kg/s Default value kg/h
Standard deviation limit  
DN 15 0.0004 1.44
DN 25 0.004 14.4
DN 50 0.015 54

Sensor size Default value kg/s Default value kg/h
Zero offset limit  
DN 15 0.0103 37.08
DN 25 0.0319 114.84
DN 50 0.1444 519.84

Sensor size Default value kg/s Default value kg/h
Low flow cut-off
DN 15 0.0103 37.08

Technical reference
B.2 Sensor dimension dependent default settings
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Sensor size Default value kg/s Default value kg/h
DN 25 0.0319 114.84
DN 50 0.1444 519.84

B.3 Exception handling
There is a defined set of exception codes to be returned by slaves in the event of problems. All 
exceptions are signalled in the response from the slave by adding 80 hex to the function code 
of the request and following this byte by an exception code.   

Table B-1 Exception codes
Exception 
code (dec)

Exception text Description

01 Illegal function The function code received in the query is not an allowable 
action for the slave

02 Illegal data address The data address received in the query is not an allowable 
address for the slave.

03 Illegal data value A value contained in the query data field is not an allowable 
value for the addressed location. This may indicate a fault in 
the structure of the remainder of a complex request, such 
that the implied length is incorrect or the number of registers 
is too high.

04 Slave device failure The request is for some other reason not acceptable. It may 
e.g. indicate that the data value to write is evaluated to be 
beyond limits.

B.4 Float definition
Stuffing of multi-byte numbers into multiple Modbus RTU registers differs among Modbus 
devices. "Big Endian" and "Little Endian" describe the order or sequence in which multi-byte data 
is stored in memory. This device uses (IEEE 741) a "Big-Endian" representation for addresses and 
data items as default. This means that when a numerical quantity larger than a single byte is 
transmitted, the MOST significant byte is sent first.
Float transmission order can be changed as described in Float transmission (Page 80).

Following example describes the  Big-Endian representing of float IEEE741.

Value (decimal) IEEE FP B MSB LSB Register N Register N + 1
high low high low

100.0 42C80000h 42h C8h 00h 00h
55.32 425D47AEh 42h 5Dh 47h AEh

2.0 40000000h 40h 00h 00h 00h
1.0 3F800000h 3Fh 80h 00h 00h
-1.0 BF800000h bFh 80h 00h 00h

Technical reference
B.4 Float definition
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Read absolute massflow (4.03001)

Query: 01,03,0B,B8,00,02,46,0A
Response: 01,03,04,40,C3,52,93,62,C8
Absolute mass‐
flow =

6.10383 kg/s

Technical reference
B.4 Float definition
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Modbus communication FC410 C
C.1 Modbus addressing model

The device allows read/write access to the following standard Modbus RTU data holding register 
blocks:
• Holding registers (ref. 4x address range)
The minimum value of a writable holding register can be read by adding 10000 to the Modbus 
address of the register.
The maximum value of a writable holding register can be read by adding 20000 to the Modbus 
address of the register.
The default value of a writable holding register can be read by adding 30000 to the Modbus 
address of the register.

C.2 Modbus function codes
This device supports following function codes: 3, 8 and 16.
Function codes 3 and 16 are used for accessing registers, max. 16 registers per read/write 
request is accepted.
Function code 8 is used for reading Modbus communication diagnostic information.
Below the various function code are described.

Function code 3 (Read holding registers)
General exceptions:
• Requesting less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)

Holes/register alignment:
• The read command always returns data if no exception is given.
• Holes in the holding register map return value zero in all bytes. E.g. reading 2 registers 

starting at 4:0004 above will result in 2 bytes of "float B" followed by 2 zeroes.
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Function code 3 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Byte count 1 byte
Register Value Hi 1 byte
Register Value Lo 1 byte
: :
Register Value Hi 1 byte
Register Value Lo 1 byte
CRC 2 bytes

Example: Read absolute massflow (address 3000)
Query: 1,3,11,184,0,2,70,10
Slave address  = 1 (0x01)
Function = 3 (0x03)
Starting Address Hi, Lo = 11, 184 (0x0B,0xB8)
Quantity of Registers Hi , Lo = 0, 2 (0x00,0x02) 
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0BB8 = 3000
Quantity of registers = 0x0002 = 2
Response: 1,3,4,64,195,82,139,98,200
Slave address  = 1 (0x01)
Function = 3 (0x03)
Byte Count  = 4 (0x04)
Register 1 - Register Value Hi, Lo = 64, 195 (0x40, 0xC3)
Register 2 - Register Value Hi, Lo = 82, 139 (0x52,  0x93)
CRC  = 98,200 (0x62, 0xC8)
Absolute mass flow = 0x40C35293 = 6.10383 kg/sec

Modbus communication FC410
C.2 Modbus function codes
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Function code 16 (Write multiple registers)
General exceptions
• Writing less than 1 or more than 16 registers => Exception 3 (Illegal data value)
• If ByteCount is not exactly 2 times NoOfRegisters => Exception 3 (Illegal data value)
• Requesting invalid start address or start address with invalid quantity => Exception 2 (Illegal 

data address)

Application exceptions:
• Application errors; min/max limit of parameter exceeded; or parameter write-protected => 

Exception 4 (Slave device error)
• Application errors include writing to ReadOnly holding registers

Holes/register alignment:
• If start-address is not the start of a mapped holding register => Exception 2 (Illegal data 

address)
• Writing to holes is allowed (ie ignored - and no exception occurs) - except for the condition 

described above
• If the end address is only part of a mapped holding register item (e.g. one half of a float 

value), the action depends on the data type. Writing parts of all data types => Exception 4 
(Slave device error)

Function code 16 example
Query
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte
Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
Byte Count 1 byte
Registers Value Hi 1 byte
Registers Value Lo 1 byte
: :
Registers Value Hi 1 byte
Registers Value Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
Starting Address Hi 1 byte

Modbus communication FC410
C.2 Modbus function codes
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Starting Address Lo 1 byte
Quantity of Registers Hi 1 byte
Quantity of Registers Lo 1 byte
CRC 2 bytes

Example: Set baud rate to 115200 baud (address 529)
Query: 1,16,2,17,0,1,2,0,5,70,210
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)  
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01)
Byte Count  = 2 (0x02)
Registers Value Hi, Lo = 0, 5 (0x00,0x05)
CRC  = 70,10 (0x46, 0x0A)
Starting address 0x0211 = 529
Number of registers = 0x0001 = 1
Data 0x0005 = (115200 = value 5)
Response: 1,16,2,17,0,1,80,116
Slave address  = 1 (0x01)
Function = 16 (0x10)
Starting Address Hi, Lo = 2, 17 (0x02,0x11)
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01) 
CRC = 80,116 (0x50, 0x74)

Function code 8 (Diagnostics)
Modbus function code 8 provides a series of tests for checking the communication system 
between a client (Master) device and a server (Slave).
The following diagnostics functions are supported:

Sub-
func‐
tion 
code 
(Dec)

Name Description

00 Return Query Data The data passed in the request data field is to be returned 
(looped back) in the response.

10 Clear Counters and Diagnostic 
Register

Clears all counters and the diagnostic register. Counters are 
also cleared upon power–up.

11 Return Bus Message Count The response data field returns the quantity of messages that 
the remote device has detected on the communications sys‐
tem since its last restart, clear counters execution, or power–
up.

12 Return Bus Communication Er‐
ror Count

The response data field returns the quantity of CRC errors en‐
countered by the remote device since its last restart, clear 
counters execution, or power–up.
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Sub-
func‐
tion 
code 
(Dec)

Name Description

13 Return Bus Exception Error 
Count

The response data field returns the quantity of MODBUS ex‐
ception responses returned by the remote device since its last 
restart, clear counters execution, or power–up.

14 Return Slave Message Count The response data field returns the quantity of messages 
broadcast or addressed to the remote device that the remote 
device has processed since its last restart, clear counters exe‐
cution, or power–up.

15 Return Slave No Response 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device for which it has returned no 
response (neither a normal response nor an exception re‐
sponse), since its last restart, clear counters execution, or 
power–up.

16 Return Slave NAK Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Negative 
Acknowledge (NAK) exception response, since its last restart, 
clear counters execution, or power–up.

17 Return Slave Busy Count The response data field returns the quantity of messages ad‐
dressed to the remote device for which it returned a Slave 
Device Busy exception response, since its last restart, clear 
counters execution, or power–up.

18 Return Bus Character Overrun 
Count

The response data field returns the quantity of messages ad‐
dressed to the remote device that it could not handle due to a 
character overrun condition, since its last restart, clear coun‐
ters execution, or power–up.

20 Clear Overrun Counter and Flag Clears the overrun error counter and resets the error flag.

Function code 8 example
Query
Slave address 1 byte
Function 1 byte
Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Response
Slave address 1 byte
Function 1 byte
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Sub-function Hi 1 byte
Sub-function Lo 1 byte
Data Hi 1 byte
Data Lo 1 byte
: :
Data Hi 1 byte
Data Lo 1 byte
CRC 2 bytes

Example: Read Return Slave Message Count (address 529)
Query: 1,8,0,14,0,0,129,200
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 0 (0x00,0x00)
CRC  = 129,200 (0x81, 0xC8)
Sub-function 0x000E = 14 = Read Return Slave Message Count
Response: 1,8,0,14,0,97,64,32
Slave address  = 1 (0x01)
Function = 8 (0x08)
Sub-function Hi, Lo = 0, 14 (0x00,0x0E)
Data Hi, Lo = 0, 97 (0x00,0x65)
CRC  =  64,32 (0x41, 0xE3)
Read Return Slave Message Count = 0x0065 = 97 message received

C.3 Changing Modbus communication settings
Changing communication parameters, for example Baud Rate, Modbus Parity Framing or Bus 
Address effects the Modbus communication as follows:
• The new settings have effect only after a reset, either by restarting the device or writing the 

value 1 to Modbus address 600 Restart communication. 
• The new settings will not have effect until the Modbus driver has responded to any ongoing 

Modbus request.
NOTICE
Setting addresses in a multidrop network
It is recommended NOT to use the default address in a multi-drop network. When setting 
device addresses, make sure that each device has a unique address. Replication of addresses 
may cause abnormal behavior of the entire serial bus and make the master unable to 
communicate with all slaves on the bus.  
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C.4 Modbus holding registers tables
In the following the Modbus RTU holding registers available for the device are described.

Note
All Write parameters require password access.

Table C-1 Process values   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

3000 float / 4 Mass flow Measured mass flow - [kg/s] - Read Only
3002 float / 4 Volume flow Measured volume flow - [m3/s] - Read Only
3004 float / 4 Density Measured density - [kg/m3] - Read Only
3010 float / 4 Media temperature Measured temperature of 

the process media
- [°C] - Read Only

3023 float / 4 Frame Tempera‐
ture

Measured temperature of 
the sensor frame(1)

- [°C] - Read Only

(1) Only available if the sensor has frame temperature measurement
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Table C-2 Units for Process values and totalizer   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7400 unsigned / 2 Mass flow unit Select unit for mass flow 
process value 

73: kilograms 
per second 
[Kg/s]
 

70: grams per 
second
71: grams per 
min
72: grams per 
hour
73: kilograms 
per second
74: kilograms 
per minute
75: kilograms 
per hour
76: kilograms 
per day
77: metric 
tons per mi‐
nute
78: metric 
tons per hour
79: metric 
tons per day
80: pounds 
per second
81: pounds 
per minute
82: pounds 
per hour
83: pounds 
per day
84: short tons 
per minute
85: short tons 
per hour
86: short tons 
per day
87: long ton 
per hour
88: long ton 
per day
253: custom‐
ized unit 

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7500 unsigned / 2 Volume flow unit Select unit for volume flow 
process value 

28: cubic me‐
ters per sec‐
ond
[m3/s]
 

15: cubic feet 
per minute
16: US gallons 
per minute
17: liters per 
minute
18: imperial 
gallons per mi‐
nute
19: cubic me‐
ters per hour
22: US gallons 
per second
23: million US 
gallons per 
day
24: liters per 
second
25: million lit‐
ers per day
26: cubic feet 
per second
27: cubic feet 
per day
28: cubic me‐
ters per sec‐
ond
29: cubic me‐
ters per day
30: imperial 
gallons per 
hour
31: imperial 
gallons per 
day
130: cubic 
feet per hour
131: cubic me‐
ters per mi‐
nute
132: barrels 
(= 42 US gal‐
lons) per sec‐
ond
133: barrels 
(= 42 US gal‐
lons) per mi‐
nute

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

134: barrels 
(= 42 US gal‐
lons) per hour
135: barrels 
(= 42 US gal‐
lons) per day
136: US gal‐
lons per hour
137: imperial 
gallons per 
second
138: liters per 
hour
170: beer bar‐
rel per second
171: beer bar‐
rel per minute
172: beer bar‐
rel per hour
173: beer bar‐
rel per day
235: US gal‐
lons per day
253: custom 
volume flow 
unit 
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

7600 unsigned / 2 Density unit Select unit for density proc‐
ess value 

92: kilograms 
per cubic me‐
ter [kg/m3]
 

91: grams per 
cubic centime‐
ters
92: kilograms 
per cubic me‐
ter
94: pounds 
per cubic foot
95: grams per 
milliliter
96: kilograms 
per liter
97: grams per 
liter
98: pounds 
per cubic inch
93: pounds 
per gallon
99: short tons 
per cubic yard
146: micro‐
grams per liter
147: micro‐
grams per cu‐
bic meter
170: milli‐
grams per liter
253: custom 
mass flow unit 

Read / 
Write

7700 unsigned / 2 Temperature unit Select unit for temperature 
process value 

32: °C
 

32: °C
33: °F
34: °R
35: K

Read / 
Write

8320 unsigned / 2 Mass totalizer units Select unit for mass totalizer 
value 

61: kilograms 
[kg]
 

60: grams
61: kilograms
62: metric 
tons
63: pounds
64: short tons
65: long tons
125: ounces
253: custom‐
ized unit 

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value range Access 
level

8456 Float / 4 Custom unit factor 
mass flow value

Custom unit for mass flow 
value, only active if custom‐
ized unit is selected
 
Calculation is based on [kg/s] 

1 0 to 
60000000
 
 

Read / 
Write

7516 Float / 4 Custom unit factor 
volume flow value

Custom unit for volume flow 
value, only active if custom‐
ized unit is selected
 
Calculation is based on [m3/s]

1 0 to 1000
 
 

Read / 
Write

8462 Float / 4 Custom unit factor 
density value

Custom unit for density val‐
ue, only active if customized 
unit is selected
 
Calculation is based on 
[kg/m3]

1 0 to 60000
 
 

Read / 
Write

8474 Float / 4 Custom unit factor 
mass totalizer

Custom unit for mass totaliz‐
er, only active if customized 
unit is selected
 
Calculation is based on [kg]

1 0 to 1000000
 
 

Read / 
Write

Table C-3 Identification   
Modbus ad‐
dress

Data type / 
Size (bytes)

Parameter Description Default value 
(unit)

Value 
range

Access 
level

4000 String / 20 Manufacturer Device manufacturer Siemens - Read Only
4020 String / 10 Sensor Firmware Re‐

vision 
Sensor firmware version - - Read Only

4025 String / 16 SensorType Sensor type. 
Also shown on the device 
nameplate

- - Read Only

4033 String / 20 Sensor Serial Number Unique sensor serial num‐
ber. 
Also shown on the device 
nameplate

- - Read Only

4095 String / 10 Sensor Hardware Re‐
vision 

Sensor hardware version - - Read Only

4100 String / 10 Sensor Frontend Type Sensor hardware variant - - Read Only
4121 String / 20 Sensor Order Number Sensor order number part 1 

(MLFB). 
Also shown on the device 
nameplate

- - Read Only

4131 String / 32 Sensor Order Number Sensor order number part 2 
(MLFB). 
Also shown on the device 
nameplate

- - Read Only
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Modbus ad‐
dress

Data type / 
Size (bytes)

Parameter Description Default value 
(unit)

Value 
range

Access 
level

4147  String / 32 Sensor Order Number Sensor order number part 3 
(MLFB). 
Also shown on the device 
nameplate

- - Read Only

4164 String / 32 Long TAG Enter a unique TAG name for 
the device (up to 32 charac‐
ters)

   

4180 String / 16 Descriptor Enter a unique description 
for the measurement point 
(up to 16 characters)

   

4188 String / 16 Startup Date Enter the installation date of 
the device

   

Table C-4 Operating conditions     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2100 Unsigned / 2 Flow Direction Define positive and negative 
flow direction. 
Default positive flow direc‐
tion is indicated by the arrow 
on the sensor.
Possible selections:
• 0: Negative: The flow is 

measured '+' in default 
negative direction and '-' 
in default positive direc‐
tion.

• 1: Positive: The flow is 
measured '+' in default 
positive direction and '-' 
in default negative direc‐
tion

1 0 to 1 Read / 
Write

2130 Unsigned / 2 Process Noise Damp‐
ing

Select process noise damp‐
ing level:
0: 55 ms filtering (Centrifu‐
gal Pump)
1: 110 ms filtering (Triplex 
Pump) 
2: 220 ms filtering (Duplex 
Pump)
3: 400 ms filtering (Simplex 
Pump)
4: 800 ms filtering (Cam 
Pump)

2 0 Low to 4 
High

Read / 
Write
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Table C-5 Mass flow   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2125 Float / 4 Low Mass flow Cut-
Off 

Set mass flow limit for low 
flow cut-off.
Below this limit mass flow 
output is forced to zero.
If Low Flow Cut-Off is set to 0, 
the cut-off functionality is 
disabled.
Notice: 
It is recommended to set a 
lower value for gas applica‐
tions.

Sensor size 
specific [kg/
s] 1)

0 to 1023 Read / 
Write

2426 Float / 4 Mass flow Correction 
Factor

Specify correction factor for 
use in the mass flow calcula‐
tion

1 -1.999 to  
+1.999

Read / 
Write

1): See Sensor dimension dependent default settings (Page 126)

Table C-6 Volume flow   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2170 Float / 4 Low Volume flow Cut 
Off

Define the numerical volume 
flow value below which the 
volume flow output is forced 
to zero.

Sensor size 
specific [m3/
s] 1)

0 to 0.177 Read / 
Write

1): See Sensor dimension dependent default settings (Page 126)

Table C-7 Density   
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2127 Float / 4 Empty Tube Limit Define threshold value of 
empty tube

500 [kg/m3] -14 000 to 
+14 000

Read / 
Write

2129 Unsigned / 2 Empty Tube Detection Set automatic detection of 
Empty Tube On/Off

0 = off (Empty tube is off).
1 = on (a density value below 
Empty Tube Limit triggers an 
alarm. All flow rate values 
are forced to zero %).

0 0 to 1
 

Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2442 Float / 4 Density Correction 
Factor 

Set density compensation 
value (gain) in order to make 
a density correction (scale 
factor).
To increase the displayed 
density value with +0.5 %, 
set the density factor to 
1.005.
The displayed density value 
will now be 0.5 % higher 
than before

1 -1.999 to  
+1.999

Read / 
Write

2444 Float / 4 Density Correction 
Offset

Set density compensation 
value (offset) in order to 
make an offset on the meas‐
ured density.
To make the flowmeter show 
+ 2 kg/m3, change the densi‐
ty offset to 2.000 kg/m3 in the 
'Sensor' menu

0 [kg/m3] -1 400 to +1 
400

Read / 
Write

Table C-8 Totalizer 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default 
value 
[unit]

Value range Access 
level

2609 unsigned / 2 Totalizer State Totalizer state 
• 0 = paused
• 1= running

1 0 to 1 Read only

2610 float / 4 Totalizer Value The totalized MASS value in 
kg

0 [kg] Min. -1.70E+38 
Max. 1.70E+38

Read Only

3018 Unsigned / 4 Totalizer fixed 
point part

The totalized MASS value in 
kg. Most significant word of 
the totalizer (MSW).
The format of the totalizer is 
a TotalType. 
The TotalType represent a 
fixed point value in the MSW 
32 bit and a fractional part in 
the LSW 32 bit.
Example: 2.03 would be rep‐
resented as fixed point part = 
2 and fractional part = 
30000000

0 [kg]
 

Min 
-2147483648
Max 
2247483647
 

Read Only
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default 
value 
[unit]

Value range Access 
level

3020 Unsigned / 4 Totalizer fractional 
part

The totalized MASS value in
kg. Least significant word of 
the totalizer (LSW).
The format of the totalizer is 
a TotalType.
The TotalType represent a 
fixed point value in the MSW 
32 bit and a fractional part in 
the LSW 32 bit.
Example: 2.03 would be rep‐
resented as fixed point part = 
2 and fractional part = 
30000000
Note: The data type is sign‐
ed32

0 [kg] Min -999999999
Max 999999999
 

Read Only

2612 unsigned / 2 Reset totalizer Reset totalizer Value - Enter 1 to reset Read / 
Write

2613 unsigned / 2 Pause totalizer Pause totalizer
Totalizer can only be paused 
when running 

- Enter 1 to pause Read / 
Write

2614 unsigned / 2 Resume totalizer Resume totalizer
Totalizer can only be re‐
sumed when paused

- Enter 1 to pause Read / 
Write

Table C-9 Access level 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

404 Unsigned / 2 Access level Access level status - 32 (logged 
in)
4 (logged 
out)

Read Only

412 Unsigned / 2 User password Password to enable writing 
commands

- 2457 (ena‐
ble user 
password
0 (disable 
user pass‐
word)

Read / 
Write
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Table C-10 Maintenance 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

700 Unsigned / 2 Set To Default Reset all parameters to facto‐
ry settings

- Enter 1 to 
reset

Write

2700 Unsigned / 4 Operating Time Total Total operating time since
first power up

0 [h] - Read Only

2702 Unsigned / 4 Operating Time Operating time since last
power up

0 [h] - Read Only

4088 String / 14 Firmware Time Stamp Firmware time stamp speci‐
fies the date and time when 
the sensor firmware was built

- - Read Only

4105 String / 32 Sensor PCBA Serial 
Number

Serial number of the sensor 
electronic

- - Read only

Table C-11 Device diagnostics
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2756 Float / 4 Driver Current Actual sensor driver current.
The actual driver current is 
viscosity and sensor size de‐
pendent

- [A] 0 to 0.124 Read Only

2758 Float / 4 Pick-up Amplitude 1 Actual pick-up 1 amplitude - [V] 0 to 0 9999 Read Only
2760 Float / 4 Pick-up Amplitude 2 Actual pick-up 2 amplitude - [V] 0 to 0 9999 Read Only
2762 Float / 4 Sensor Frequency Actual sensor frequency - [Hz] 0 to 1 023 Read Only
3032 Float / 4 PCB Temperature Actual sensor electronic tem‐

perature
- [C°] -50 to 200 Read Only

Table C-12 Aerated flow
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2200 Unsigned / 2 Aerated Flow Alarm 
Limit

Alarm limit calculated in per 
cent of accepted bad meas‐
urements.

80 [%] 0 to 99 Read / 
Write

2201 Unsigned / 2 Aerated Flow Warn‐
ing Limit

Warning limit calculated in 
per cent of accepted bad 
measurements

0 [%] 0 to 99 Read / 
Write

2202 Unsigned / 2 Measurement Sam‐
ple Time

The time period over which 
the actual percentage of bad 
measurements is calculated

5 [s] 1 to 10 Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2203 Unsigned / 2 Aerated Flow Filter Aerated flow filter
0: Disabled
1: Enabled
2: Auto
Auto means that filtering 
starts automatically when 
aerated flow is measured.

2 0 to 2 Read / 
Write

2204 Unsigned / 2 Filter Time Constant PV Filter Time Constant
0: 0.5 seconds
1: 1 second
2: 2 seconds
3: 5 seconds
4: 10 seconds
5: 20 seconds
6: 30 seconds
7: User Defined Value

4 0 to 7 Read / 
Write

2205 Float / 4 Filter Start Hysteresis The filter is active when the 
hysteresis value is exceeded.
Aerated Flow Filter must be 
set to Auto

0.015 [V] 0 to 0.124 Read / 
Write

2207 Unsigned / 2 Minimum Filtering 
Time

The filtering time is reset 
each time hysteresis band is 
exceeded

10 [ms cycles] 0 to 65535 Read / 
Write

2214 Unsigned / 2 Pickup Amplitude Fil‐
ter

Enable/disable pickup ampli‐
tude filter.
0 = Disable
1 = Enable

1 0 to 1 Read / 
Write

2215 Unsigned /
2

Bad Measurement 
Count

Number of bad measure‐
ments counted during the 
last period

0 0 - 65535 Read Only

2216 Unsigned /
2

Filter Iteration Set the number of times to 
repeat the same filter. In‐
creasing the number will in‐
crease the damping.
Active only if Filter Time Con‐
stant is set to 7.

3 1 to 5 Read /
Write

2217 Unsigned /
2

Bandwidth Factor Increase the Bandwidth Fac‐
tor to reduce the LP (low 
pass) bandwidth filtering.
Active only if Filter Time Con‐
stant is set to 7.

2 0 to 4 Read /
Write

2218 Unsigned /
2

Filter Pole Shift Configure the bandwidth 
and damping in the stop 
band. A high number will 
give a small bandwidth and 
an increased damping in the 
stop band.
Active only if Filter Time Con‐
stant is set to 7.

2 1 to 5 Read /
Write
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Table C-13 Zero point adjustment
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2132 Unsigned / 2 Zero Point Adjust‐
ment

Select zero-point adjustment 
method. Automatic zero 
point adjustment is recom‐
mended.
• 0 = Auto
• 1 = Manual

0 0 to 1 Read / 
Write

2133 Float / 4 Manual Zero Point 
Offset

Enter agreed zero point off‐
set value for manual zero 
point adjustment mode.

0 [kg/s] 0 to  1023
 

Read / 
Write

2135 Unsigned / 2 Zero Point Duration Define duration of zero point 
adjustment.

30 [s] 1 to 999 Read / 
Write

2136 Float / 4 Standard Deviation Standard deviation during 
auto zero point adjustment

0 [kg/s] -1023 to 
+1023

Read  only

2138 Float / 4 Standard Deviation 
Limit

Set limit for zero point adjust‐
ment Standard Deviation 
value. If the Standard Devi‐
ation exceeds the Standard 
Deviation Limit, the auto 
zero point adjustment is 
aborted.

Sensor size 
specific [kg/
s] 1)

0 to +1023 Read / 
Write

2140 Float / 4 Zero Point Offsett Lim‐
it

Set limit for zero point offset.
If the zero point offset ex‐
ceeds the zero point offset 
limit, the zero point offset 
cannot be stored

Sensor size 
specific [kg/
s] 1)

-1023 to 
+1023

Read / 
Write

2142 Float / 4 Zero Point Offset Val‐
ue

Default zero point offset 
based on factory calibration 
of sensor. 
A Zero point offset compen‐
sates for sensor variations 
due to process conditions.

0 [kg/s] -1023 to 
+1023

Read only

2144 Unsigned / 2 Zero Point Adjust Pro‐
gress

Shows the progress of the 
currently running Zero Point 
adjustment in percentage

0 [%] 0 to 100 Read Only
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2145 Unsigned / 2 Zero Point Adjust Sta‐
tus

Status of the last zero point 
adjustment performed
Every high bit ('1') represents 
an error occurred in the last 
zero point adjustment per‐
formed.

No high bits equals ok.
Bit 0  = Zero sigma limit ex‐
ceeded
Bit 1 = Zero offset limit excee‐
ded
Bit 2 = Quality of zero point 
conditions 

- • 1
• 2
• 4

Read Only

2180 Unsigned / 2 Start Zero Point Ad‐
justment

Start automatic zero point 
adjustment.
The automatic zero point ad‐
justment determines the ap‐
plication specific zero point 
offset automatically.
Possible selections:
• 0: Idle
• 1: Running
• 2: Start

0 0 to 2 Read / 
Write

1): See Sensor dimension dependent default settings (Page 126)

Table C-14 Modbus     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

527 Unsigned / 2 Float byte order The float byte order used in 
Modbus messages.

Selection 0: Byte order: 
1-0-3-2
Selection 1: Byte order: 
0-1-2-3
Selection 2: Byte order: 
2-3-0-1
Selection 3: Byte order: 
3-2-1-0

The first mentioned byte is 
the first byte sent.
Byte 3 corresponds to the 
left-most byte (MSB) of a 32 
bit float in big endian format, 
byte 0 corresponds to the 
right-most byte (LSB).

3 0 to 3 Read / 
Write

528 Unsigned / 2 Modbus Address Set Modbus Device Address 1 1 to 247 Read / 
Write
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

529 Unsigned / 2 Baudrate Set communication bau‐
drate.
Following baud rates are 
available:
• 0 = 9600 
• 1 = 19200 (Default)
• 2 = 115200
• 4 = 38400
• 5 = 57600
• 6 =76800

1 0 to 5 Read / 
Write

530 Unsigned / 2 Modbus Parity Fram‐
ing

RS-485 parity and framing
8 databits are always used

0 = even parity, 1 stopbit
1 = odd parity, 1 stopbit
2 = no parity, 2 stopbits

0 0 to 2 Read / 
Write

600 Unsigned / 2 Restart communica‐
tion
 

Restart Modbus communica‐
tion
Write:
• 0 = No effect
• 1 = Restart
Read:
• Always 0

- 0 to 1 Write

Table C-15 Sensor 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2113 Float / 4 Minimum Frame Tem‐
perature

Lower limit of the frame tem‐
perature

-50 [°C]  Read only

2115 Float / 4 Maximum Frame 
Temperature

Lower limit of the frame tem‐
perature

200 [°C]  Read only

4043 String / 16 Sensor size Nominal sensor diameter 
(DN)

- - Read only

4051 String / 32 Hazardous area ap‐
proval

Hazardous area approval of 
the sensor

- - Read only

4078 String / 20 Wetted materials Sensor enclosure material - - Read Only
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Table C-16 Volume flow calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2103 Float / 4 Maximum Volume 
flow Capacity

Maximum volume flow
measurement capacity of 
the sensor

Sensor size 
specific [m3/
s] 1)

0 to 0.177 Read only

1): See Sensor dimension dependent default settings (Page 126).

Table C-17 Mass flow calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2101 Float / 4 Maximum Mass flow 
Capacity

Maximum mass flow
measurement capacity of 
the sensor

Sensor size 
specific [kg/
s] 1)

0 to 1023 Read only

2402 Float / 4 Calibration Factor Factory-set sensor-specific
calibration factor.
The calibration factor is
shown on the sensor name‐
plate

- Min: 5.00E
+07
Max: 4.29E
+09

Read only

1): See Sensor dimension dependent default settings (Page 126).

Table C-18 Density calibration
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2428 Float / 4 Density Calibration 
Offset

Specify an offset in the den‐
sity flow calculation

- -14 000 to 
+14 000

Read only

2430 Float / 4 Density Calibration 
Factor 

Specify gain factor in the 
density flow calculation

- -21474835
83 to 
214748358
3

Read only

2432 Float / 4 Dens. Comp. Tube 
Temp.

Specifies a tube temperature 
coefficient in the density cal‐
culation

- -0.001953 
to 
+0.001953

Read only

2434 Float / 4 Dens. Comp. Frame 
Temp.

Specifies a frame tempera‐
ture coefficient in the density 
calculation

- -0.001953 
to 
+0.001953

Read only
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Table C-19 Simulation     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

2764 Float / 4 Mass flow Simulation 
Value

Set mass flow simulation val‐
ue.  
The mass flow will be set to 
this value on all outputs, 
if Simulation Mass Flow is 
enabled

0 [kg/s] -1023 to 
+1023

Read / 
Write

2766 Float / 4 Density Simulation 
Value

Set density simulation value. 
The density will be set to this 
value on all outputs, if Simu‐
lation Density is enabled

1000 [kg/m3] -20000 to 
+20000

Read / 
Write

2768 Float / 4 Media Temperature 
Simulation Value

Set media temperature simu‐
lation value. The media tem‐
perature will be set to this 
value on all outputs if Simu‐
lation media Temperature 
is enabled

0 [°C] -50 to +200 Read / 
Write

2770 Float / 4 Frame Temperature 
Simulation Value

Set frame temperature simu‐
lation value. 
The frame temperature will 
be set to this value on all out‐
puts if Simulation Frame 
Temperature is enabled

0 [°C] -50 to +200 Read / 
Write

2772 Float / 4 Volume flow Simula‐
tion Value

Set volume flow simulation 
value. 
The volume flow will be set 
to this value on all outputs, 
if Simulation Volume Flow 
is enabled

m3/s -65 to +65 Read / 
Write

2780 Unsigned / 2 Enable Simulation Activate simulation.
Select one of the following 
values:
• Bit 0: Mass flow
• Bit 1: Density
• Bit 2: Volume flow
• Bit 3: Media temperature
• Bit 4: Frame temperature

0  0 to 63 Read / 
Write
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Table C-20 Alarms     
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3012 Unsigned / 4 Alarm Group 1 The following bit is set in 
case of active alarm:
• Bit 4:

Power Supply Malfunc‐
tion

• Bit 6:
Temperature Circuit Mal‐
function

• Bit 10:  
Measurement Out Of 
Range

• Bit 14:
Calibration Malfunction

• Bit 15:
Compensation Out Of 
Range

• Bit 17:
Pickup Malfunction

• Bit 23:
Driver Malfunction

• Bit 26:
Measurement Out Of 
Range

• Bit 27:
Mass Flow Max Limit Ex‐
ceeded

• Bit 28:
Volume Flow Max Limit 
Exceeded

• Bit 29:
Density Max Limit Excee‐
ded

• Bit 30:
Min Tube Temp Exceeded

• Bit 31:
Max Tube Temp Exceeded

- - Read Only
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Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3014 Unsigned / 4 Alarm Group 2 The following bit is set in 
case of active alarm:
• Bit 0:

Min Frame Temp Excee‐
ded

• Bit 1:
Max Frame Temp Excee‐
ded

• Bit 2:
Zero Sigma Limit Excee‐
ded

• Bit 3:
Zero Offset Limit Excee‐
ded

• Bit 4:
Quality Of Zero Point 
Conditions

• Bit 5:
Empty Pipe

• Bit 6:
Sensor Partially Filled

• Bit 7:
Storage Malfunction

• Bit 8:
System Internal

• Bit 14:
Unstable Measurement 
Conditions

• Bit 15:
Auto-filtering enabled

• Bit 23:
Sensor Startup

- - Read Only
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Table C-21 Quality code for process values 
Modbus ad‐
dress

Data type / 
Size [bytes]

Parameter Description Default value 
[unit]

Value 
range

Access 
level

3014 Unsigned / 4 Alarm Group 2 Quality code of a measured 
value

Process values 
for quality co‐
des
Media temper‐
ature
Density
Volume flow
Mass flow
Quality code 
for each proc‐
ess value con‐
sist of 2 bits:
Bit 24/25:
Media temper‐
ature
Bit 26/27:
Density
Bit 28/29:
Volume flow
Bit 30/31:
Mass flow

11 Good
01 Reserved
10 Simula‐
tion
00 Bad

Read Only
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Index

A
Accuracy

Density, 104
Mass flow, 104
Media temperature, 104

Applications, 27
Approval information nameplate

Sensor, 26

C
Cable requirements, 45
Cable specifications, 107
Catalog

catalog sheets, 123
Certificates, 11, 123
Certificates and approvals, 109, 110
Characteristics

Density calibration, 152
Mass flow calibration, 152
Sensor, 151
Volume flow calibration, 152

Cleaning, 84
Commissioning

Steps, 51
Communication

Modbus, 150
Communication parameters

Setup, 54
Coriolis

Measurement principle, 125
Cross talk, 36, 100
Customer Support, (Refer to Technical support)

D
Design, 21

Sensor, 106
Designated use, 105
Device

identification, 22
Diagnosing

with SIMATIC PDM, 101
Diagnostics, 92
Dimensions and weight, 119
Disassembly, 39

Disposal, 90
Document history, 7
Documentation

Edition, 7
Downloads, 123

E
Electrical connection

Cable requirements, 45
In hazardous area, 44

Empty tube monitoring, 77
Exception codes, 129

F
Flow direction, 33

G
General information nameplate, 22

Sensor, 23

H
Handling, 35
Hazardous area

Electrical connection, 44
Laws and directives, 11
Qualified personnel, 13

Hazardous locations
Approvals, 14

Hot swappable, 89
Hotline, (Refer to Support request)

I
Icons, (see Symbol)
Identification

Sensor, 142
Installation

Gas, 33
Incorrect, 100
Inlet / Outlet conditions, 32
Liquid, 33
Location in the system, 32
Mounting of sensor, 35
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Orienting the sensor, 34
Safety instructions, 32
Upstream / Downstream, 32

Installation torques, 105
Internet

Modbus Organisation, 20

L
Laws and directives

Disassembly, 11
Personel, 11

Low flow cut-off, 76, 99

M
Maintenance, 83, 86

device status symbols, 91
Maintenance and Diagnostics

Access level, 146, 156
Aerated flow, 147
Device diagnostics, 147
Maintenance, 147
Zero point adjustment, 149

Manuals, 123
Mass flow cut-off limit, 76
Modbus

Features, 19
Frame, 20
Network, 53
Organisation Website, 20
Technical data, 110
Technology, 19

Modbus holding registers
Alarms, 154
Characteristics, 151
Communication, 150
Identification, 142
Maintenance & Diagnostics, 146, 156
Process values, 137
Setup, 143
Simulation, 153
Totalizer, 145

Modifications
correct usage, 11
improper, 11

Mounting, (See Installation)

N
Nameplates

Approval information, 26
General information, 22, 23
Specific information, 25

P
PDM

Commissioning steps, 51
Performance, 103
Power supply, 103, 107
Pressure

Safety instructions, 32
Process noise damping, 77
Process values, 71, 137
Process variables, 109

Q
Qualified personnel, 13

R
Rated operating conditions, 108
Recalibration, 84
Reference conditions, 103
Repair, 86
Return procedure, 89

S
Safety

Sensor installation, 32
Scope of delivery, 9
Sensor dimension dependent default settings

Fraction, 128
Mass flow, 126
Standard volume flow, 127
Volume flowt, 127
Zero point adjustment, 128

Sensor orientation, (See Installation)
SensorFlash, 110
Service, 86, 124
Service and support

Internet, 124
Service information, 87
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Setup
Density, 144
Mass flow, 144
Operating conditions, 143
Volume flow, 144

Signal processing, 126
SIMATIC PDM

Zero point adjustment, 63
Simulation, 80, 153
Specific information nameplate

Sensor, 25
Support, 124
Support request, 124
Symbol

configuration, 91
device status, 91
diagnostics, 91
maintenance, 91
operating mode, 91
process value, 91

Symbols, (Refer to warning symbols)
System design, 105
System integration, 19

T
Technical data, 103, 105, 110
Technical support, 124

partner, 124
personal contact, 124

Termination DIP switches, 47
Test certificates, 11
Totalizer, 145

U
Unicast communication mode, 20
Units for Process values and totalizer, 138

V
Vibrations, 35, 100
Volume flow cut-off limit, 76

W
Warning symbols, 11
Warranty, 10

Z
Zero point adjustment, 74

Automatic, 74
Manual, 76
via SIMATIC PDM, 63

Index

SITRANS FC410/FCS400
Operating Instructions, 06/2020, A5E39789214-AB 159



Index

SITRANS FC410/FCS400
160 Operating Instructions, 06/2020, A5E39789214-AB


	SITRANS FC410/FCS400
	Legal information - Warning notice system
	Table of contents
	1 Introduction
	1.1 Document history
	1.2 Product compatibility FC410
	1.3 Items supplied
	1.4 Checking the consignment
	1.5 Security information
	1.6 Transportation and storage

	2 Safety notes
	2.1 Preconditions for use
	2.2 Laws and directives
	2.2.1 Conformity with European directives

	2.3 Requirements for special applications
	2.4 Use in hazardous areas
	2.4.1 Installation in hazardous areas
	2.4.2 Maximum temperature specifications for Ex use


	3 Description
	3.1 System integration
	3.2 Modbus RTU technology FC410
	3.3 Design
	3.4 Nameplate layout
	3.5 Features
	3.6 Applications
	3.7 Approvals

	4 Installing/mounting
	4.1 Basic safety notes
	4.1.1 Installation location requirements
	4.1.2 Proper mounting

	4.2 Installation instructions
	4.2.1 Sensor installation
	4.2.1.1 Mounting the sensor
	4.2.1.2 Hydrostatic testing
	4.2.1.3 Installing with insulation
	4.2.1.4 Pressure guard


	4.3 Disassembly

	5 Connecting
	5.1 Basic safety notes
	5.2 Wiring
	5.3 Connecting FC410/FCS400
	5.3.1 Setting the EOL termination DIP switches


	6 Commissioning
	6.1 Basic safety notes
	6.2 General requirements
	6.3 Remote commissioning with PDM FC410
	6.3.1 Functions in SIMATIC PDM
	6.3.2 Commissioning steps
	6.3.3 Initial setup
	6.3.4 Adding a device to communication network
	6.3.5 Configuring a new device
	6.3.6 Wizard - Quick Start via PDM
	6.3.7 Wizard - Zero Point Adjustment
	6.3.8 Changing parameter settings using SIMATIC PDM
	6.3.9 Parameters accessed via drop-down menus
	6.3.10 Process values


	7 Operating FC410
	7.1 Remote operation
	7.1.1 Overview of device configuration software
	7.1.2 SIMATIC PDM
	7.1.2.1 Check SIMATIC PDM version
	7.1.2.2 Updating the Electronic Device Description (EDD)
	7.1.2.3 Set address



	8 Parameter assignment FC410
	8.1 Functions
	8.1.1 Process values
	8.1.2 Low flow cut-off
	8.1.3 Empty tube monitoring
	8.1.4 Process noise damping
	8.1.5 Totalizer
	8.1.6 Security
	8.1.7 Simulation
	8.1.8 Float transmission


	9 Service and maintenance
	9.1 Basic safety notes
	9.2 Recalibration
	9.3 Cleaning
	9.4 Maintenance and repair work 
	9.4.1 Maintenance information FC410
	9.4.2 Service information FC410

	9.5 Replacing the device
	9.6 Spare parts/Accessories
	9.6.1 Ordering of spare parts
	9.6.2 Replaceable components

	9.7 Transportation and storage
	9.8 Return procedure
	9.9 Disposal
	9.9.1 Special disposal required


	10 Diagnostics and troubleshooting FC410
	10.1 Device status symbols
	10.2 Fault codes and corrective actions
	10.2.1 Diagnostics
	10.2.2 Alarm messages

	10.3 Operation troubleshooting
	10.3.1 Updating the firmware
	10.3.2 Troubleshooting sensor-related problems
	10.3.2.1 Step 1: Inspecting the application
	10.3.2.2 Step 2: Performing a zero point adjustment
	10.3.2.3 Step 3: Calculating the measurement error
	10.3.2.4 Step 4: Improving the application


	10.4 Diagnosing with PDM

	11 Technical data
	11.1 Power
	11.2 Performance
	11.3 Construction
	11.4 Sensor design
	11.5 Basic electrical requirement for master system
	11.6 Cables and cable entries
	11.7 Operating conditions
	11.8 Process variables FC410
	11.9 Approvals note
	11.10 Certificates and approvals
	11.11 SensorFlash
	11.12 Modbus Communication Specification
	11.13 PED
	11.14 Pressure - temperature ratings
	11.14.1 Stainless steel sensors
	11.14.2 Pressure drop curves


	12 Dimension drawings
	12.1 Sensor dimensions
	12.2 316L stainless steel - standard & hygienic
	12.3 316L stainless steel - NAMUR
	12.4 316L stainless steel - Hygienic versions

	A Product documentation and support
	A.1 Product documentation
	A.2 Technical support

	B Technical reference
	B.1 Theory of operation
	B.2 Sensor dimension dependent default settings
	B.2.1 Mass flow
	B.2.2 Volume flow
	B.2.3 Standard volume flow
	B.2.4 Fraction
	B.2.5 Zero point adjustment

	B.3 Exception handling
	B.4 Float definition

	C Modbus communication FC410
	C.1 Modbus addressing model
	C.2 Modbus function codes
	C.3 Changing Modbus communication settings
	C.4 Modbus holding registers tables

	Index

